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Tivoli Netcool Performance Manager - Alcatel-Lucent 5620
SAM LogToFile 2.1.0.0 Technology Pack Installation and User
Guide

The IBM Tivoli Netcool Performance Manager - Alcatel-Lucent 5620 SAM LogToFile
2.1.0.0 Technology Pack Installation and User Guide describes how to install and
configure the various components such as:

e IBM InfoSphere Information Server
* IBM InfoSphere Information Client
* Apache ActiveMQ

Apart from these installations, this guide also talks about the following topics:
* Job related tasks

* The devices and technologies that operate in the Alcatel-Lucent 5620 SAM
LogToFile 2.1.0.0 Technology Pack environment.

Intended audience

The audiences for this manual are the network administration engineers at IBM
customer sites who will install, configure, and use the Alcatel-Lucent 5620 SAM
LogToFile 2.1.0.0 Technology Pack as part of their Tivoli Netcool Performance
Manager installation.

To install and use the Alcatel-Lucent 5620 SAM LogToFile 2.1.0.0 Technology Pack,
you should have a working knowledge of the following subjects:

* Tivoli Netcool Performance Manager DataMart

¢ Tivoli Netcool Performance Manager Administrators

e TCP/IP networks

* Tivoli Netcool Performance Manager Wireline Technology Pack Developers
¢ IBM Business Partners

The audiences should also be familiar with the specific technology that the
Alcatel-Lucent 5620 SAM LogToFile 2.1.0.0 Technology Pack deals with.

Tivoli Netcool Performance Manager - Wireline Component

IBM® Tivoli Netcool Performance Manager consists of a wireline component
(formerly Netcool/Proviso) and a wireless component (formerly Tivoli® Netcool®
Performance Manager for Wireless).

Tivoli Netcool Performance Manager - Wireline Component consists of the
following subcomponents:

* DataMart is a set of management, configuration, and troubleshooting GUIs. The
Tivoli Netcool Performance Manager System Administrator uses the GUIs to
define policies and configuration, and to verify and troubleshoot operations.

* DataLoad provides flexible, distributed data collection and data import of SNMP
and non-SNMP data to a centralized database.

© Copyright IBM Corp. 2013 v



* DataChannel aggregates the data collected through Tivoli Netcool Performance
Manager Dataload for use by the Tivoli Netcool Performance Manager
DataView reporting functions. It also processes online calculations and detects
real-time threshold violations.

* DataView is a reliable application server for on-demand, web-based network
reports.

¢ Technology Packs extend the Tivoli Netcool Performance Manager system with
service-ready reports for network operations, business development, and
customer viewing.

The following figure shows the different Tivoli Netcool Performance Manager

modules.
Dataload
SHNMP
Collector o DataChannel
Processor

Datal cad e DataView
SNMP > (Tivoli
Collector I |nteg[a];ed
Portal)
» DataMart
Applications

Datal oad o] DataChannel
Bulk Stats Processor
Collector

Tivoli Netcool Performance Manager documentation consists of the following:
* Release notes

* Configuration recommendations

* User guides

* Technical notes

* Online help

The documentation is available for viewing and downloading on the information
center at |http:/ /publib.boulder.ibm.com /infocenter/ tivihelp /v8r1/topic/|
fcom.ibm.tnpm.doc/welcome_tnpm.html|
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Chapter 1. Alcatel-Lucent 5620 SAM LogToFile 2.1.0.0
Technology Pack overview

The LogToFile feature has been added to the SAM server to allow downstream
systems to retrieve metric data as it arrives and without any filtering. The data is
fed to the downstream systems in a streaming fashion. The downstream system
must do the filtering with caution and as necessary.

In the earlier releases of Alcatel-Lucent 5620 SAM Technology Pack, FindToFile
feature is used to obtain the metric data from SAM Server for any time period you
desire. Though this feature is convenient, FindToFile feature adds additional
computational burden to the SAM Server. The new LogToFile feature relieves the
SAM server of the burden of querying and filtering for the subset of data that the
downstream system needs.

UBA structure

An array of UBAs is divided into UBAs for accounting metrics and UBAs for
performance metrics. There can be many UBAs. However, all UBAs must have the
accounting and performance metrics. These UBAs process the inventory data and
metric data that is presented to them by IBM InfoSphere Information Server
DataStage.

The XML files and JMS messages from the SAM server are parsed by DataStage
and turned into CSV files for the UBAs. DataStage produces one file per UBA per
period.

The incoming CSV files are processed by a single Input schema in the UBA. The
record types in the incoming CSV files are heterogeneous. The inventory data is
moved to the CSV file only if under the following conditions:

* When there is a full dump.
* When any JMS inventory message are received.

The inventory and data records are in CSV format, with an initial integer identifier
that specifies a record type, and the subsequent fields containing the actual data of
the record. For example, Record type identifier, fieldl, field2, field3,
fieldN. A type of "0" indicates a meta record that describes the record schema for
another record type. The second field of the meta records indicates the record type
that it defines.

Dynamic models

In the previous versions of Alcatel-Lucent 5620 SAM Technology Pack, the SAMIF
and BLB communicate directly with SAM server. SAMIF acquires and processes
inventory via bulk transfer (full dump) and JMS messages (changes). BLB issues
periodic SOAP FindToFlle requests for metric data and acquires that data over
S/FTP and makes it available to the UBAs. SAMIF communicated via JMS, SOAP,
and S/FTP to acquire and process inventory. The BLB communicated via SOAP
and S/FTP to export and acquire bulk metric data files. There is one UBA that
processes performance metrics and another that processes accounting metrics. This
design does not accommodate more than two UBAs. In the current design SAMIF
and BLB are removed and DataStage is used to interface with the SAM server by

© Copyright IBM Corp. 2013 1



using JMS, SOAP and S/FTP. You can have an array of UBAs that are subdivided
into UBAs for accounting metrics and UBAs for polled metrics.

Currently, Alcatel-Lucent 5620 SAM LogToFile 2.1.0.0 Technology Pack uses
DataStage that interfaces with the SAM server and provides metric and inventory
data to the UBAs. Rather than having a separate component to process inventory
for the entire system, inventory is processed inline by the UBAs. DataStage
performs the following functions:

* Acquires and processes inventory and metrics from SAM in XML format

* Filters the inventory and metric data. This function was previously handled by
SAM server

* Partition data by UBA based partition key. This information are taken from
Proviso DB.

* Waits for complete data for a period.
* Handles the window period.
* Merges metrics and inventory into one CSV file per period per subchannel

Data collection model

The Alcatel-Lucent 5620 SAM LogToFile 2.1.0.0 Technology Pack integrates with
the Alcatel-Lucent 5620 SAM Server and IBM InfoSphere DataStage for collecting
performance metrics and accounting metrics. These metrics are for the networking
infrastructure and services that the Alcatel-Lucent 5620 SAM LogToFile manages.

2 IBM Tivoli Netcool Performance Manager: Alcatel-Lucent 5620 SAM LogToFile 2.1.0.0 Technology Pack Installation and User
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Figure 1. Data collection model for the Alcatel-Lucent 5620 SAM LogToFile 2.1.0.0 Technology Pack

Communication between Tivoli Netcool Performance Manager components and
Alcatel-Lucent 5620 SAM LogToFile 2.1.0.0 Technology Package is through the
SOAP /XML interface and XML files. SOAP is a lightweight XML-based messaging
protocol that is used to encode the information in web service request and
response messages before sending them over a network. SOAP messages are
independent of any operating system or protocol and can be transported by using
various Internet protocols, including Simple Mail Transfer Protocol (SMTP),
Multipurpose Internet Mail Extensions (MIME), and Hyper Text Transfer Protocol
(HTTP).

DataStage performs the SOAP/XML and JMS interactions, and the initial
processing of all inventory and metrics. DataStage parses the XML files and JMS
messages from the SAM server and transfers the data to the UBAs as CSV files.
DataStage produces one file per UBA per period. These XML files contain
interleaved records of inventory and metric data. The inventory data is moved to
the CSV file only if under the following conditions:

* When there is a full dump.
* When any JMS inventory message are received.

The inventory and data records are in CSV format, with an initial integer identifier
that specifies a record type, and the subsequent fields contain the actual data of the
record. The incoming CSV files are processed by a single Input schema in the UBA.
The record types in the incoming CSV files are heterogeneous. For more
information about the file formats, see[“Bulk input file formats” on page 8

Chapter 1. Alcatel-Lucent 5620 SAM LogToFile 2.1.0.0 Technology Pack overview 3



The UBAs handle processing of both inventory and metric files and JMS messages.
A random number of UBAs can be configured to handle this process with each one
designated either as Accounting UBA or Performance UBA.

These XML files are then collected and processed, with the results presented in a
set of web-based reports, which are listed and described in Alcatel-Lucent 5620
SAM LogToFile 2.1.0.0 Technology Pack Reference.

Inventory
The Alcatel-Lucent 5620 SAM LogToFile contains an object database that
represents the network resources and their relationships to other network
resources. It also represents some abstract resources and relationships.
Services and their owners (called Subscribers) are represented, along with
their relationships to each other and to the Service Access Point Queues.

Metrics
DataStage periodically makes requests to the SAM server to retrieve SAM
statistics for one period. The SAM statistics are then passed to the UBA for
parsing and processing into Tivoli Netcool Performance Manager metrics.

shows that the Alcatel-Lucent 5620 SAM LogToFile 2.1.0.0 Technology
Pack manages the inventory of the resources and metrics, real, and abstract, in two
ways:

* Complete data collection for inventory and metrics

* Event-driven data collection for inventory

Complete data collection

In the complete data collection, DataStage sends SOAP /XML requests to
the Alcatel-Lucent 5620 SAM LogToFile for each SAM object type that is
needed to run the inventory and metric data collection. Specifically, the
request is for XML files that contain information about all instances of that
object type and metrics. The requests from DataStage specify result filter of
property values that are returned for each SAM object type. This filter
operation limits the set of property values to those that matter to the
technology pack inventory.

DataStage partitions the Proviso database on IP address and merge metrics
and inventory into one CSV file per period per subchannel that is then
delivered to the UBAs in CSV format.

When the inventory and metrics are in separate bulk input files (as is the
case in the Alcatel-Lucent 5620 SAM environment), a technology pack
developer typically implements several types of bulk adapter design files,
as described in Bulk adapter design files.

Event-driven data collection for inventory

The Alcatel-Lucent 5620 SAM uses the JMS to view real-time events and
alarm feed information from the managed network. For more information,
see the Alcatel- Lucent 5620 SAM-O OSS Interface Developer Guide. DataStage
establishes a JMS connection with SAM to receive inventory updates and
notices of metric data file availability. SAM JMS client daemon listens for
JMS messages from SAM and passes them to Apache ActiveMQ queue.
DataStage job reads the messages from queue and processes them.

Note: Alcatel-Lucent 5620 SAM-O is an open interface on the
Alcatel-Lucent 5620 SAM. An OSS client application can access information

4  1BM Tivoli Netcool Performance Manager: Alcatel-Lucent 5620 SAM LogToFile 2.1.0.0 Technology Pack Installation and User
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through the Alcatel-Lucent 5620 SAM-O.
shows that in the event-driven inventory, DataStage processes JMS
create, delete, and update messages.

DataStage resynchronize the element names that are based on IP address
and subchannel affiliations from the Tivoli Netcool Performance Manager
database on startup. For newly encountered elements, a hash of the
element name IP address is used to assign it to a subchannel. It is not
necessary for DataStage to write the element to the Tivoli Netcool
Performance Manager database. The UBAs generate the elements and other
inventory. By default, the hash function is used and applied to the entire
set of accounting or metric subchannels. However, it is possible through
configuration to restrict the assigned subchannels to a subset of the
accounting or metric subchannels. This is provided in the event one
subchannel starts to approach capacity. In addition, the user might
explicitly override the subchannel affiliation for individual IP addresses.
This is intended to all for the case that a network has a handful of large
devices that they want to ensure are evenly distributed across the available
subchannels. Metrics and inventory are merged together and appended to
a file destined for a subchannel (with the IP address determining the
destination subchannel). After the data for a period is complete, the file is
cut and staged atomically for UBA acquisition.

When the DataStage is started, it establishes the SAM metric data by using
the new LogToFile feature. Availability of metric file is notified to the
DataStage through JMS connection. DataStage then retrieves the file.
DataStage used S/FTP connections for multiple downloads rather than
establish new connections for every download.

DataStage also establishes a JMS connection with SAM to receive inventory
updates, file available messages and control messages. The JMS process is
running continuously. The Monitor stage in job periodically checks and
restarts the JMS daemon if the daemon is not running. JMS daemon buffers
messages and pass the messages to DataStage.

DataStage also processes the full inventory dump by using the existing
FindToFile SOAP requests. Full dump on inventory is run on need basis.
There is no automated full dump on startup. Warnings can be found in the
logs showing missed JMS messages. These warnings can be monitored to
initiate a full dump if required.

Finally, DataStage requires that all inventory update messages have
information to help determine the IP address. DataStage requires the IP
address to determine to which subchannel an inventory update must be
routed.

Alcatel-Lucent 5620 SAM LogToFile 2.1.0.0 Technology Pack
job design

IBM InfoSphere Information Server is an Extraction Transformation And Loading
(ETL) solution tool that manages data arriving in real-time as well as data received
on a periodic or scheduled basis. The scalable platform enables companies to solve
large-scale business problems through high-performance processing of massive
data volumes and also provides extensibility to develop custom plug-ins.

The features of Alcatel-Lucent 5620 SAM LogToFile 2.1.0.0 Technology Pack job
design are as follows:

Chapter 1. Alcatel-Lucent 5620 SAM LogToFile 2.1.0.0 Technology Pack overview 5



LogTofile interface to SAM server
LogToFile solution relieves loads from SAM server thus allowing SAM
server to support higher performance load.

Class record filter option
Data from SAM server are not filtered. Filtering the class records reduces
loads from DataStage and UBA processing.

Multiple UBA Partition
This solution supports multiple sets of Accounting and Performance UBAs
to support UBA and Data Channel scalability.

Period window handling
Class Data from LogToFile might not arrive within the period interval. To
ensure data completeness, job waits for late data files and merge the data
into its correct period interval.

CSV output for UBAs
CSV file requires less processing effort that is compared to XML. Multiple
small files are bundled in single UBA input to improve 1/O utilization.

6 IBM Tivoli Netcool Performance Manager: Alcatel-Lucent 5620 SAM LogToFile 2.1.0.0 Technology Pack Installation and User
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Chapter 2. Devices and services

In this topic, you will learn details about Alcatel-Lucent SAM 5620 LogToFile
server compatibility, supported devices, Alcatel-Lucent SAM 5620 LogToFile
services, data collection model, bulk input file formats, and bulk adapter design
files.

Alcatel-Lucent 5620 SAM server compatibility

The Alcatel-Lucent 5620 SAM LogToFile 2.1.0.0 Technology Pack currently runs on
the Alcatel-lucent 5620 SAM Server Release 10

Supported devices

The list of devices that are supported by the Alcatel-Lucent SAM 5620 LogToFile
Technology Pack depends on the version of the technology pack.

Devices supported in this release

This version of the Alcatel-Lucent SAM 5620 LogToFile Technology Pack supports
the following devices:

* Alcatel-Lucent 7750 Service Router

* Alcatel-Lucent 7710 Service Router

* Alcatel-Lucent 7705 Service Aggregation Router
* Alcatel-Lucent 7450 Ethernet Service Switch

* Alcatel-Lucent 7210 Service Access Switch

* Alcatel-Lucent OmniSwitch 6850

* Alcatel-Lucent OmniSwitch 6250

For more information about these devices, see [http://www.alcatel-lucent.com|

How the devices are supported

The Alcatel-Lucent 5620 SAM LogToFile Technology Pack supports these devices in
the following ways:

Defines data generation, data storage, and data collection methods

The Alcatel-Lucent 5620 SAM LogToFile Technology Pack communicates with the
device through the Simple Object Access Protocol / Extensible Markup Language
(SOAP/XML) interface, and uses JMS for notification of inventory changes. See
[“Data collection model” on page 2| for more information about the SOAP /XML
interface and other components associated with the data collection model.

Defines Tivoli Netcool Performance Manager properties

The Alcatel-Lucent 5620 SAM defines and manages all of the relevant objects
associated with the device in the Alcatel-Lucent XML-based equipment package.
The Alcatel-Lucent SAM 5620 LogToFile Technology Pack maps the appropriate set
of SAM object properties defined in the equipment package to Tivoli Netcool
Performance Manager Properties. In general, the Netcool Performance Manager
property name is the same as the SAM object property name, except that the
Netcool Performance Manager property name also has the prefix “sam”. For
information about the properties currently supported by the Alcatel-Lucent SAM
5620 LogToFile Technology Pack, see the IBM Tivoli Netcool Performance Manager

© Copyright IBM Corp. 2013 7


For more information about these devices, see http://www.alcatel-lucent.com

Alcatel-Lucent SAM LogToFile 5620 2.1.0.0 Technology Pack Reference.

Alcatel-Lucent 5620 SAM LogToFile services

Alcatel-Lucent 5620 SAM users can configure services such as VPRN, VPLS, and
customer or subscriber sites to the core network at the SAPs

A user might also configure a set of policies to manage different classes of traffic at
the SAPs. A SAP can have one policy applied for ingress traffic, and another for
egress (to the customer site). The Alcatel-Lucent 5620 SAM has a predefined set of
8 traffic classes: be, 12, af, 11, h2, ef, h1, and nc. In addition, the Alcatel-Lucent 5620
SAM LogToFile supports unicast, multicast, and broadcast IP traffic.

A user can define a policy to manage each combination of traffic classes and cast
types uniquely. With eight classes and four types, 32 different combinations are
possible. On a SAP, each unique combination is supported by a separate queue,
which means up to 32 queues to be managed. On ingress, the SAPs support
separate queues for the different casts of traffic. However, on egress, the SAPs do
not support separate queues. Therefore, on egress, there is a maximum of eight
queues.

The Alcatel-Lucent 5620 SAM represents these entities in the following objects:

e SAPs: A SAP object represents a SAP. The SAP object has a Policyld property.

* Policies: The Policy object represents the policy.

* ForwardingClasses: A ForwardingClass object represents one of the eight
possible classes of traffic. This object has a Policyld property that indicates the
policy to which it belongs. If the object is an ingress ForwardingClass, it has four
queue IDs, one each for Unicast, Multicast, Broadcast, and Other. If the object is
an egress ForwardingClass, it has one queue ID.

* Service queues: An Egress Service Queue object or an Ingress Service Queue
object represents a service queue on a SAP.

Bulk input file formats

DataStage produces one file for each UBA per period. These files contain
interleaved records of inventory and metric data.

The inventory and data records are in the CSV format. The initial integer identifier
of the CSV files specifies a record type, and the subsequent fields contain the
actual data of the record. The output CSV file from the Datastage has two sections:

1. Header
2. Result or body

The header starts with 0 (zero), and is called as the 0-Record schema. The Result or
body starts with record type, which is identical to the one that is defined in the
Header.

Sample Header
0’ n { n Ilr\ecord‘rypell n : 17’ n IldataTypell n . n IICII n , n Ilc'l aSSNamell n :
""equipment.Shelf"",""fieldNames"":[""administrativeState"",
""deviceState"",""displayedName"",""equipmentState"",
""numberOfCardSTots"",""objectFul1Name"",""operationalState"",
n Ilshe'l fIdII n , n Ilshe‘l fNamell n , n Ilshe‘l nypell n , n Ils.ite:[dll n , n Ils.iteNamell II] } n

Sample result or body
17,"noop","deviceStateUnknown","sim242_60","indeterminate","12",

8 IBM Tivoli Netcool Performance Manager: Alcatel-Lucent 5620 SAM LogToFile 2.1.0.0 Technology Pack Installation and User
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"network:138.120.242.60:shelf-1","unknown","1","sim242_60",
"sr_shelf 12Sl1ot","138.120.242.60","sim242_60"

The following list contains the definition of 0-Record CSV data type:
e 'A’ - Attribute Change

* 'D' - Object Deletion

e 'C' - Object Creation

e 'C' - Full Dump

* 'M' — Metrics

The JMS identifiers for the data types are A and D
The data that is passed in to the CSV file are:

1. className in the J]MS message
2. objectName in the JMS message
3. Data that is available in the body of the JMS message

Bulk input file schema

The UBA input has a schema that works on CSV input files. The general format of
a CSV file is mentioned below:

0, "{"recordType": 1, "dataType":"input source", "className":
"TheClassName", "fieldNames": ["fieldl", "field2", ... "fieldn"]}"

recordType
Specifies an integer that is used to identify the record format

dataType
Specifies the source of the record data. The sources can be "A", "D", "C", or
HM”

className
Specifies the ALU class name that is used to identify the class (can be
inventory or metric) that this record belongs to. The class name is used by
the UBA to identify the mapping between the class and the record
identifier.

fieldnames
Specifies an array of the field names that is available within the record that
is defined.

The following is an example of the CSV file that defines record type 0:
* 0,{"recordType":1,"dataType":"M","className":"rtr.RouteStatsLogRecord",

"fieldNames":["bgpRoutes","isisRoutes","monitoredObjectPointer",
"monitoredObjectSiteld","timeCaptured"]}

The fields in the above mentioned CSV file are as follows:

monitoredObjectPointer
10.1.241.76:shelf-1:cardSlot-1:card:daughterCardSlot-2:daughterCard:port-2

receivedOctetsPeriodic
15034

receivedUnicastPacketsPeriodic
98

periodicTime
1340775894000
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Tivoli Netcool Performance Manager bulk adapters support bulk input files in the
CSV format. The DataStage server produces data in CSV format, and uses JMS for
notification of inventory changes.

Each UBA technology pack provides at least one bulk adapter design file to define
the data format supported by that technology pack. Technology pack developers
implement bulk adapter design files using JavaScript®. Some technology packs
provide several bulk adapter design files.

A bulk adapter design file typically can process both inventory and metrics data
from the same bulk input file, and provides a function that creates the bulk
collection formula names. When the inventory and metrics are located in separate
bulk input files (as is the case in the Alcatel-Lucent 5620 SAM environment), a
technology pack developer typically implements several types of bulk adapter
design files. The Alcatel-Lucent 5620 SAM LogToFile Technology Pack provides the
UBA design files.

UBA design files

The Universal Bulk Adaptor (UBA) is a DataChannel application that interprets
and parses bulk input files that contain inventory and metrics data, or (as is the
case in the Alcatel-Lucent 5620 SAM environment) metrics data only. A technology
pack developer implements UBA design files that tell the UBA application how to
interpret and parse these bulk input files.

The current version of the Alcatel-Lucent 5620 SAM LogToFile Technology Pack
supports two UBA Bulk Collectors. Therefore, the Alcatel-Lucent 5620 SAM
LogToFile Technology Pack provides two main UBA design files:

* The SAMUBAAdaptor_polled.js file is used by the first UBA Bulk Collector and
handles most of the metrics.

* The SAMUBAAdaptor_accounting.js file is used by the second (accounting) UBA
Bulk Collector and handles the accounting metrics. These metrics are
service-oriented metrics.

The Alcatel-Lucent 5620 SAM Technology Pack provides the following UBA design
files:

* AppLogger.js

* SAMBLBAdaptor.js

* SAMCommon.js

¢ SAMDomainModel.js

* SAMIFAdaptor.js

* SAMIF_aingr_aengr_forwarding_class.js
* SAMIF_aingr_aengr_policy.js

* SAMIF_aingr_aengr_queue.js

* SAMIF_aosqos_policy.js

* SAMIF_cfm_ethernet.js

* SAMIF_cfm_loopback.js

* SAMIF_cfm_oneway_delay.js

e SAMIF_cfm_single_ended_loss.js

* SAMIF_cfm_twoway_delay.js

* SAMIF_equipment_cardSlot.js

¢ SAMIF_equipment_channel.js

* SAMIF_equipment_hw_environment.js
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SAMIF_equipment_physical_port.js
SAMIF_equipment_shelf.js
SAMIF_ethernetoam_mep.js
SAMIF_icmp_ping.js
SAMIF_lag_interface.js
SAMIF_mpls_dynamic_lsp.js
SAMIF_mpls_interface.js
SAMIF_mpls_ping js

SAMIF_mpls_site.js
SAMIF_ppp_control_protocol.js
SAMIF_ppp_interface.js
SAMIF_properties.js
SAMIF_rtr_virtual_router.js
SAMIF_selectJmsVersion.js
SAMIF_service_access_interface.js
SAMIF_service_access_point.js

SAMIF _service_epipe.js

SAMIF _service_site_ping.js
SAMIF_service_vpls.js
SAMIF_svq_aggregation_scheduler.js
SAMIF_svt_sdp_binding.js
SAMIF_svt_tunnel_ping.js
SAMIF_svt_vcecv_ping.js
SAMUBAAdaptor_accounting.js
SAMUBAAdaptor_polled.js
SAMUBA_OAM_ping_results.js

SAMUBA _aosqos_policy.js

SAMUBA _avail_aggregator.js

SAMUBA _avail_extensions.js

SAMUBA _avail_operator.js

SAMUBA _avail_schema.js

SAMUBA _cfm_ethernet.js
SAMUBA_cfm_oneway_delay,js

SAMUBA _cfm_single_ended_loss.js
SAMUBA_equipment_allocated_memory.js
SAMUBA _equipment_available_memory.js
SAMUBA _equipment_cardSlot.js

SAMUBA _equipment_digital_diagnostic_monitoring.js
SAMUBA _equipment_interface.js
SAMUBA _equipment_interface_additional.js
SAMUBA _equipment_media_independent.js
SAMUBA _equipment_system_cpu.js
SAMUBA _equipment_system_memory.js
SAMUBA _ethernet_equipment_dot3_stats.js
SAMUBA _handlers.js

Chapter 2. Devices and services
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* SAMUBA_hw_environment.js

* SAMUBA_jms_handlers.js

* SAMUBA_metrics.js

* SAMUBA_mpls_interface.js

* SAMUBA_mpls_site.js

* SAMUBA_mss.js

* SAMUBA_nqueue_combined_network_egress.js
* SAMUBA_nqueue_combined_network_ingress.js
* SAMUBA_ppp_control_protocol.js

* SAMUBA_ppp_interface.js

* SAMUBA _rtr_route_stats.js

* SAMUBA_schema.js

* SAMUBA_sdp_binding_base_stats.js

* SAMUBA_svc_complete_service_egress.js
* SAMUBA_svc_complete_service_ingress.js
* SAMUBA_svc_pppoe.js

* SAM_app_config.js

* SAM_hash_array.js

* SAM_property_mapping.js

* SAM_property_storage.js

* SAM_soap_filterjs

* jms_2_0,js

* jms_2_1]s

* jms_3_0,js
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Chapter 3. Installing the Alcatel-Lucent 5620 SAM LogToFile
2.1.0.0 Technology Pack

The Topology Editor was introduced at the same time as the 4.3-U technology pack
release. All 4.3-U or higher UBA technology pack installations require the Topology
Editor to configure the technology pack. Configuration details are described in the
Pack Installation and Configuration Guide. You can install the Alcatel-Lucent 5620
SAM LogToFile 2.1.0.0 Technology Pack either from a launchpad or by using the
command line.

Tivoli Netcool Performance Manager supports the 4.3-U or higher technology pack
installation procedures.

All technology packs, both legacy bundle and stand-alone packs, require the
Technology Pack Installer. Always use the latest Technology Pack Installer,
regardless of the version of the technology pack.

Important: A new Technology Pack Installer is released in 1.3-G release with the
version 3.3.1.0. This version has no feature enhancements but is released for license
text changes.

Note: Since the release of 4.3-W technology packs, the former Starter Kit was
renamed to Pack Bundle Prerequisite pack. It is contained in the legacy bundle and
is only required to be installed with a legacy pack that is also contained in a legacy
bundle.

All technology packs require that the Starter Kit or the Pack Bundle Prerequisite
Pack to be installed.

Prerequisite software

Ensure that you fulfil these prerequisites before you install and configure the
Alcatel-Lucent 5620 SAM LogToFile 2.1.0.0 Technology Pack.

Prerequisite software for Alcatel-Lucent 5620 SAM LogToFile
2.1.0.0 Technology Pack installation

You must have all the prerequisite software and required information before you
install and configure a technology pack.

 IBM Tivoli Netcool Performance Manager 1.3.2. Additionally, you require the
following fix packs:

- 1.3.2.0-TIV-TNPM-IF0018

Note: This fix pack contains DataStage license changes for Tivoli Netcool
Performance Manager and IBM InfoSphere Information Server installation
media.

- Supported platforms for IBM InfoSphere Information Server v8.7 server:
Redhat Linux 5.5 and above (x86-64)

- Supported platforms for IBM InfoSphere Information Server v8.7 client:
Windows XP, Windows Vista, Windows 7, Windows 2008

- 1.3.2.0-TIV-TNPM-IF0019
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Note: This fix pack contains the DataChannel fixes to support IBM
InfoSphere Information Server for logtofile implementation in Alcatel-Lucent
5620 SAM LogToFile 2.1.0.0 Technology Pack.

» UBA collectors. You can add UBA collectors as described in Add a Collector in the
IBM Tivoli Netcool Performance Manager: Installation Guide and associate it with a
UBA pack as part of this technology pack installation.

* Ensure that you have access to the Tivoli Netcool Performance Manager
DataMart server that is running an X Window System server.

Note: If there is no graphics card on the DataMart server, the Xvfb virtual frame
buffer package that provides X Window System services is automatically
installed. For more information, see Setting Up a Remote X Window Display in the
IBM Tivoli Netcool Performance Manager: Installation Guide.

* Ensure that you have access to the Tivoli Integrated Portal.
* Ensure that you have access to the DataChannel server.

* Ensure that you have access to the Alcatel-Lucent 5620 SAM LogToFile 2.1.0.0
Technology Pack installation files on one of the following locations:

— Product distribution site: |https://www-112.ibm.com /software /howtobuy /|
[softwareandservices] On the product distribution site are the
ProvisoPackInstaller.jar file, and technology pack JAR files.

— Tivoli Netcool Performance Manager CD distribution, which contains the
ProvisoPackInstaller.jar file, technology pack JAR files, and the JAR files
for the Starter Kit components.
For more information about the Starter Kit, see [“Preinstallation setup tasks”|
For more information about obtaining software, see your IBM customer
representative.

* The correct version of Java. For more information, see IBM Tivoli Netcool
Performance Manager: Configuration Recommendations Guide.

* Apache ActiveMQ v5.5.1 that is bundled with the Alcatel-Lucent 5620 SAM
LogToFile 2.1.0.0 Technology Pack JAR file.

Additional information
Before configuring a technology pack, ensure that you:

* Have the following documentation for your version of Tivoli Netcool
Performance Manager:
— IBM Tivoli Netcool Performance Manager: Pack Release Notes for the current
technology pack release

— IBM Tivoli Netcool Performance Manager: Installation Guide

— IBM Tivoli Netcool Performance Manager: Upgrade Guide (if you are upgrading
the core software)

— IBM Tivoli Netcool Performance Manager: Pack Upgrade Guide (if you are
upgrading the technology-pack software)

— IBM Tivoli Netcool Performance Manager: DataMart Configuration Guide

Note: Refer to this guide to create an inventory profile and initiate a
discovery.

* Ensure that you have access to the following site to check for interim fixes or fix
packs that might apply to your technology pack:

http:/ /www-306.ibm.com /software /sysmemt/products /support/|
NetcoolProviso.html|
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* The Tivoli Netcool Performance Manager documentation and the IBM Tivoli
Netcool Performance Manager: Pack Release Notes, which are available on the
following website:

http:/ /publib.boulder.ibm.com/infocenter/tivihelp/v8r1/topic/com.ibm.netcooll
_pm.doc/welcome_tnpm.html|

¢ The Oracle TNS name of the server on which you installed Oracle server with
the Tivoli Netcool Performance Manager database configuration. For more
information, see Specifying a Basename for DB_USER_ROOT in the IBM Tivoli
Netcool Performance Manager: Installation Guide.

Preinstallation setup tasks

Ensure that all necessary configuration steps are completed on the prerequisite
software.

* Completed the following tasks:
— Reviewed the release notes for the current technology pack.

Note: Release notes contain important information that you need to consider
before installing a technology pack. They also contain information about
specific patches that need to be installed before you configure a technology
pack

— Installed the 1.3.2 version of the Tivoli Netcool Performance Manager
components, as described in the IBM Tivoli Netcool Performance Manager:
Installation Guide.

— Configured at least one DataChannel.
— Created a user on the server with permission to FTP and delete files.
* Open a terminal emulator and log on to the DataMart server as pvuser.

* Change your working directory to the DataMart home directory (/opt/datamart,
by default).
* Load the shell with the DataMart environment by sourcing the dataMart.env
file, as follows:
. /opt/datamart/dataMart.env

Note: After you load the DataMart environment into the shell, the PVMHOME
variable is set to the DataMart home directory, /opt/datamart, by default. These
instructions assume that this variable is set.

* Set and export the DISPLAY environment variable (see Setting Up a Remote X
Window Display in the IBM Tivoli Netcool Performance Manager: Installation Guide),
so that the Technology Pack Installer GUI displays back on your system.

* Installed the Technology Pack.

Note: Localization is done automatically during installation of the technology
pack.
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Preparing the Alcatel-Lucent 5620 SAM LogToFile 2.1.0.0 Technology
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You can obtain technology pack installation files from the IBM product distribution
website, or from the Tivoli Netcool Performance Manager technology pack CD.

Before you begin

If you are installing the packs using an instance of the Tivoli Netcool Performance
Manager launchpad on the local file system, you can install directly from the CD.
Otherwise, you must create a temporary directory and copy the technology pack
files to the local system before you begin the installation. You cannot run the
launchpad from the Tivoli Netcool Performance Manager DVD, and then install
technology packs directly from the CD distribution.

Note: If you are using a local instance of the launchpad and you want to install
directly from the technology pack CD, you can skip this step and proceed to
Chapter 3, “Installing the Alcatel-Lucent 5620 SAM LogToFile 2.1.0.0 Technologyj
Pack,” on page 13

Procedure

1. On the system where DataMart is located, use the mkdir command to create
app-packs directory to hold the technology pack JAR files and the
ProvisoPackInstaller.jar file, for example:
mkdir -p $PVMHOME/version/app-packs

2. If you want to use technology packs from the IBM product distribution
website, download the JAR files by following these steps:

a. Use the cd command to change your working directory to the app-packs
directory that you created in Step 1. For example:
cd $PVMHOME/version/app-packs
b. Download the following from this website:
[https: / /www-112.ibm.com /software /howtobuy /softwareandservices

* ProvisoPackInstaller.jar file

* JAR files for technology packs you want to install (the bundled JAR file
for bundled packs or individual JAR files for stand-alone packs)

3. If you want to use technology packs from the Tivoli Netcool Performance
Manager technology pack CD, browse to the /Proviso/AP/jar location on the
CD and copy the following files to the temporary directory:

* ProvisoPackInstaller.jar file

* JAR files for technology packs you want to install (the bundled JAR file for
bundled packs or individual JAR files for stand-alone packs)

4. Unmount the CD.
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Installing the technology pack by using the launchpad

Use this information to install a technology pack by using the launchpad.
Before you begin

Check the version of Java running on your system by entering the following
command:

java -version

You might need to upgrade your version of Java depending on the technology
pack release.

Important: For 4.3-U and higher technology packs, the launchpad requires you to
enter the path to supported Java runtime binary files. Only version 1.5.0_b(14+) is
supported. The Tivoli Netcool Performance Manager topology editor provides a
supported version of the Java binary files. Using the older Java version might
result in an error detailing that it is not possible to proceed with the installation.

About this task

To install a Tivoli Netcool Performance Manager technology pack, follow these
steps:

Procedure
1. Start the installer as follows:

a. If it is not already open, open the launchpad (see Starting the Launchpad in
the IBM Tivoli Netcool Performance Manager: Installation Guide).

Note: Open a terminal emulator and log on to the DataMart server as
pvuser. You must su to root. Otherwise, the launchpad fails to start.

b. On the launchpad, click Install Technology Pack.
c. On the Install Technology Pack window, enter the following information:
* The DataMart home directory (for example,/opt/datamart, by default).

* The Java run time environment home directory (for example,
/opt/IBM/proviso/topologyEditor/jre/bin).

Note: For information about supported JRE versions, see the IBM Tivoli
Netcool Performance Manager: Configuration Recommendations.

* The Tivoli Netcool Performance Manager user (for example, pvuser).

d. Click the Install Technology Pack link.
A window prompts you to select the technology pack installation setup
directory.

e. Click Browse to locate the temporary directory (§PVMHOME/version/app-
packs) that you created in [‘Preparing the Alcatel-Lucent 5620 SAM|
[LogToFile 2.1.0.0 Technology Pack installation directory” on page 16 or the
directory on the Tivoli Netcool Performance Manager CD where the pack
JAR files are located (by default, /Proviso/AP/jar).

The technology pack can be loaded to the server where the Tivoli Netcool
Performance Manager database is installed.

f. Click the directory, and then click Select to display the specified directory
in the window.
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9.
10.

g. Click OK.
When the Technology Pack Installer starts, it displays a Tivoli Netcool
Performance Manager Technology Packs Welcome window.

Click Next.

Accept the license agreement, and then click Next.

The Technology Pack Installer displays the Database Access Parameters
window with the parameter values that you specified when installing and
configuring Oracle, the Tivoli Netcool Performance Manager database, and
Tivoli Netcool Performance Manager DataMart. For more information, see
Installing and configuring the prerequisite software and Installing in a distributed
environment in the IBM Tivoli Netcool Performance Manager: Installation Guide.

Re-enter the password of the database user, which is PV by default.

Click Next to continue.

The Technology Pack Installer displays the Tivoli Integrated Portal access
parameter values that you specified when installing and configuring Tivoli
Netcool Performance Manager DataView as described in Installing in a
distributed environment in the IBM Tivoli Netcool Performance Manager:
Installation Guide.

Note: The Technology Pack Installer GUI always displays 16315 as the default
port number for Tivoli Integrated Portal. If you want to use a different port
number, you must give the port number at the time of Tivoli Netcool
Performance Manager installation. Otherwise, the Technology Pack Installer
displays an error message and you cannot proceed with the installation.

Re-enter the password, which is tipadmin for the Tivoli Integrated Portal user.
The Technology Pack Installer displays a Feature Selection window, which lists
all the packs you downloaded to the directory created in|”Preparing tha

Alcatel-Lucent 5620 SAM LogToFile 2.1.0.0 Technology Pack installation|

directory” on page 16|in the left panel. All the packs are automatically

selected for installation.

Clear any technology packs in the list that you do not want to install, and
then click Next.

Note: The prerequisites for technology packs item in the Feature Selection
window is always installed. You cannot clear this item. The Starter Kit is not
included in this item.

Depending on the type of packs you install, you might be presented with
slightly different windows.

Click Next to start the installation.

As the stand-alone packs are installed, the Technology Pack Installer displays
the name of each pack and indicates the progress. When the installation
completes, the Technology Pack Install Complete window is displayed.

Click Finish to exit the Technology Pack Installer.
Go to|What to do next|section to perform post-installation tasks.

What to do next

After the installation completes, do the following:

Important: A technology pack does not work until it is configured. After
configuring the technology pack, data is collected and reports are populated.

Add a UBA collector as described inf’Adding a UBA collector for a UBA pack”]
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« Configure the technology pack as described in |[Chapter 4, “Configure the
[technology pack,” on page 21/

UBA collectors

The UBA collector is associated with two DataChannel components:

¢ Complex Metric Engine (CME) x.x - Performs calculations on the collected
data.

¢ File Transfer Engine (FTE) x.x - Transfers files from the collector output
directories and places them in the input directory of the CME.

Note: Topology Editor includes the channel and collector numbers in the
component names. For example, Data Channel 1 could have Collector UBA 1.1,
with Complex Metric Engine 1.1 and File Transfer Engine 1.1.

The FTE writes data to the file /var/adm/wtmpx on each system that hosts a
collector. As part of routine maintenance, check the size of this file to prevent it
from growing too large. For more information about Disk Quota Management,
see IBM Tivoli Netcool Performance Manager: Installation Guide.

Note: The Solaris version can be configured with strict access default settings for
secure environments. Strict FTP access settings might interfere with automatic
transfers between a DataChannel subchannel and the DataLoad server. Check for
FTP lockouts in /etc/ftpd/ftpusers, and check for strict FTP rules in
/etc/ftpd/ftpaccess.

Follow the instructions in|“Adding a UBA collector for a UBA pack.”]

Adding a UBA collector for a UBA pack

Use this information to add a UBA collector.

About this task
To add a UBA collector, follow these steps:

Procedure
1. Load the pack XSD file into an existing topology, as follows:

a. If it is not already open, open the Topology Editor (see Starting the Topology
Editor in the IBM Tivoli Netcool Performance Manager: Installation Guide).

b. Open a deployed topology (a topology.xml file) (see Opening an Existing
Topology File in the IBM Tivoli Netcool Performance Manager: Installation
Guide).

c. In the Technology Pack view, right-click the Technology Packs folder and
select Load Technology Pack from the menu.

The Load the technology pack configuration metadata window displays.
There are two radio buttons: XSD file and JAR file.

d. Click the JAR file radio button and select Browse.
There is a known issue and a workaround for opening an XSD file from a
UBA pack. For more information, see UBA pack XSD file inside a JAR file
cannot be loaded into the Topology Editor section in IBM Tivoli Netcool
Performance Manager: Pack Release Notes.

e. Using the Directory: field, the up and down arrows, and the Folders pane
on the configuration metadata window, go to the directory where the
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technology pack JAR files exist (for example, $PVMHOME/APFiles or a
directory on the Tivoli Netcool Performance Manager CD).

. Select a technology pack JAR file, and then click OK. The pack JAR file is

displayed in the configuration metadata window.

g. Click Finish. The Topology Editor adds the selected stand-alone technology

pack to the list of technology packs displayed in the Technology Packs
view.

2. After loading a UBA pack XSD file, you must add a UBA collector and
associate it with a UBA technology pack as follows:

. In the Logical view, right-click the DataChannel x folder and select from the

Add collector UBA menu.
The Configure Collector window opens.

. Select the technology pack (for example, Alcatel-Lucent 5620 SAM LogToFile)

from the list of technology packs, and then click Next.

. Using the list of available hosts on the Configure Collector window, select

the workstation that hosts the collector (for example, corinth).

d. Accept the default collector number (for example, 2).
e. Click Finish.

The Topology Editor displays the new collector under the DataChannelx
folder in the Logical view.

. Highlight the collector to view its properties. The Topology Editor displays

both the UBA collector core parameters and the UBA technology
pack-specific parameters. The core parameters are configured with all UBA
technology packs. Review the values for the parameters to make sure that
they are valid. For information about the core parameters, see the IBM Tivoli
Netcool Performance Manager: Property Reference Guide. For information about

the pack-specific parameters, see the Topology Editor Help.

g. To add additional UBA collectors for a UBA technology pack, repeat
Step 2-a through Step 2-f.

h. Redeploy the updated topology (see Starting the Deployer in the IBM Tivoli

Netcool Performance Manager: Installation Guide).
3. Configure the UBA technology packs.

Log files
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The Technology Pack Installer writes log files to the /usr/tmp directory.

Log files in this directory contain a detailed history of the tasks the Technology

Pack Installer performs as it installs technology packs. You can check this log file
to help solve any issues that might occur during technology pack installation. For
example, a log file might contain a message that indicates that the Technology Pack

Installer GUI could not display back on your system because the DISPLAY

environment variable was not set. For more information, see Setting Up a Remote X

Window Display in the IBM Tivoli Netcool Performance Manager: Installation Guide.

Log files for bulk technology packs are named installertimestamp.1og, where
timestamp is the time the file was created in seconds since the UNIX epoch. Log
files for stand-alone packs are named:
APInstalltimestamp.log.

For technology packs, log file names have the format APInstallnumber.10g.
For example: APInstal11311248677586.109.



Chapter 4. Configure the technology pack

In this topic, you will learn how to configure the Alcatel-Lucent 5620 SAM
LogToFile 2.1.0.0 Technology pack.

Before you begin

Ensure that you:

* Have the following software and documentation for your version of Tivoli
Netcool Performance Manager:

IBM Tivoli Netcool Performance Manager: Pack Release Notes for the current
technology pack release

IBM Tivoli Netcool Performance Manager: Installation Guide.

IBM Tivoli Netcool Performance Manager: Pack Installation and Configuration
Guide.

IBM Tivoli Netcool Performance Manager: DataMart Configuration and Operation
Guide.

Important: Refer to this guide to run a bulk inventory profile.
Access to the Tivoli Netcool Performance Manager DataMart server

Note: Alcatel-Lucent 5620 SAM LogToFile 2.1.0.0 Technology pack is
supported on Tivoli Netcool Performance Manager 1.3.2.

An X Window server on the DataMart server
Access to the Tivoli Integrated Portal
Access to the DataChannel server.

* Have completed the following tasks:

Reviewed the release notes for the current technology pack.

Note: Release notes contain important information you need to consider
before installing a technology pack. They also contain information on specific
patches that need to be installed before you configure a technology pack.
Installed the current version of the Tivoli Netcool Performance Manager
components, as described in the IBM Tivoli Netcool Performance Manager:
Installation Guide.

Installed the Alcatel-Lucent 5620 SAM LogToFile 2.1.0.0 Technology Pack.
Configured at least one DataChannel.
Configured two UBA Bulk Collector subchannels.

Created a user on the Alcatel-Lucent 5620 SAM server with permission to ftp
and delete files.

* Configured the XSD file. To configure the XSD file,

1.
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Open the Topology Editor, and click Topology > Open existing topology to
load existing topology from database

On the Technology Packs pane, load the Alcatel-Lucent SAM 5620 LogToFile
XSD file.

In the Logical View, create the following collectors on any new or existing
channels, and configure their corresponding parameters:

— Performance UBA
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— Accounting UBA

4. Click Run > Run Deployer for Installation to deploy the topology that you
configured.

To configure the Alcatel-Lucent 5620 SAM LogToFile 2.1.0.0 Technology Pack,
follow these steps:

Procedure

1. Load the DataMart environment. To load the shell with the DataMart
environment, follow these steps:

a. Log in to the DataMart server as pvuser.

b. Create a new folder DATA_CHANNEL_HOME/scripts/
alcatel 5620 sam_log2file.

c. Change your working directory to the DataMart home directory
(/opt/datamart, by default), using the following command: $ cd
/opt/datamart

d. Load the shell with the DataMart environment, by sourcing the
dataMart.env file, as follows: $ . /opt/datamart/dataMart.env

Note: After you load the DataMart environment into the shell, the
PVMHOME variable is set to the DataMart home directory, /opt/datamart
by default. These instructions assume that this variable has been set.

2. Copy technology-specific files from the DataMart server to the DataChannel
server. Technology-specific files are used to associate a UBA technology pack
with a specific instance of the UBA.

Note: While it is possible to install DataMart and DataChannel on the same
server, in a typical installation these modules are installed on separate servers.
If this is the case, use ftp to copy the technology-specific files. Otherwise, if
DataMart and DataChannel are on the same server, use the cp command to
copy the files to the appropriate DataChannel directory.

To copy technology-specific files to the DataChannel server, follow these steps:

a. Log in to the Tivoli Netcool Performance Manager DataChannel server by
entering the user name and password that you specified when installing
and configuring a DataChannel. The default user name and password are
pvuser and PV, respectively.

b. Change your working directory to the DATA_CHANNEL_HOME/scripts/
alcatel_5620_sam_log2file directory by entering the following command,
replacing DATA_CHANNEL_HOME with the DataChannel home directory
(/opt/datachannel, by default): $ cd DATA_CHANNEL_HOME/scripts/
alcatel_5620_sam_log2file

c. Using the ftp utility in text mode, log into the DataMart server using the
appropriate user name and password (pvuser and PV, by default).

d. Using the cd subcommand, change your working directory to the
$PVMHOME/APFiles/alcatel_5620_sam log2file/datachannel/scripts/
alcatel_5620_sam_log2file directory.

e. Using the get subcommand, copy the bulk adapter design files (*.js), scripts
(if any), and other files (if any) from the DataMart server to the
DataChannel server.

f. Exit the ftp utility by entering the bye subcommand.

g. Verify that the technology-specific files are now located in the target
directory as follows:
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* Verify that the bulk adapter design files (*.js), scripts, other files (if any)
are now located in the $ cd DATA_CHANNEL HOME/scripts/
alcatel_5620_sam_log2file directory.

3. Copy the sam0Oss.jar file to the IBM InfoSphere Information Server. The
sam0ss. jar file is distributed on a SAM distribution DVD referred to as the
5620 SAM software DVD-ROM, and is located in the following directory:
<SAM_ROOT_RELEASE_DIR>/nms/integrations/SAM_O,

You must copy the sam0ss.jar file from the directory on the DVD to the
/opt/IBM/InformationServer/Server/Projects/UDM/udm/jar directory.

4. Activate data collection requests. During installation of the technology pack, all
predefined data collection requests are promoted to the database and set to
inactive (that is, idle displays in the Active column of the Tivoli Netcool
Performance Manager DataMart Request Editor). You need to activate these
predefined data collection requests using the Request Editor. To set data
collection requests to active, follow these steps:

a. Change your working directory to $PVMHOME/bin (/opt/datamart/bin, by
default) on the DataMart server.

b. Invoke the DataMart GUI by entering the following command and pressing
Enter: § pvm

c. Click the Configuration tab, then click Request Editor to open the Request
Editor.

d. Click the Collection tab.

e. Click Refresh. The predefined data collection requests are loaded into the
Request Editor from the database.

—n

Click the Inactive button in the Filter group box to display only idle
requests.

g. In the Sub-Element Groups pane, select all idle data collection requests in
the following group or groups: Root->Sub-Element Collect->Alcatel-
Lucent 5620 SAM

h. Click the Active box under Details. The Request Editor toggles the idle
setting for these data collection requests from idle to active in the Active
column.

i. Click Save.

5. Load the DataChannel environment. In subsequent steps, you will execute
dcemd commands. To ensure that you can run these commands, load the shell
with the DataChannel environment by following these steps:

a. Log in to the DataChannel server as pvuser.

b. Change your working directory to the DataChannel home directory
(/opt/datachannel, by default), using the following command: $ cd
/opt/datachannel

c. Load the shell with the DataChannel environment, by sourcing the
dataChannel.env file, as follows: $ . /opt/datachannel/dataChannel.env

6. Restart the DataChannel to activate the UBA and read in changes to the
deployed topology.

a. Open a terminal emulator on the DataChannel server.

b. Use the dccmd command to stop all DataChannel applications: $ dcemd
stop all

c. Use the dccmd command to release all daemons running in the
DataChannel: $ dccmd forget all

d. Use the following command to find the process identifiers (pids) associated
with the DataChannel visual processes: $ findvisual
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e. Use the following commands to stop each DataChannel visual process:

$ kill -9 <cnsw_pid>
$ kill -9 <logw_pid>
$ kill -9 <amgrw_pid>
$ kill -9 <cmgrw_pid>

f. Use the following commands to restart each DataChannel visual process:

$ cnsw
$ Togw
$ amgrw
$ cmgrw

g. Use the dccmd command to start all DataChannel applications: $ dcemd

start all

h. Use the dcemd command to verify that all of the DataChannel applications
started properly: $ dcemd status all More specifically, make sure that the
UBA application associated with the DataChannel that you configured for
the Alcatel-Lucent SAM 5620 LogToFile Technology Pack is running.

i. Watch the output of the status switch to verify that all the necessary
processes are running. If these processes are running, run the tail utility on
the log file for the UBA by issuing a command similar to the following: tail
-f DATA_CHANNEL_HOME/log/proviso.log | grep
UBA.<channel_number>.<collector_number>- | more where:

Variable

Meaning

<channel_number>

Specifies the channel number.

<collector_number>

Specifies the collector number (for example,
100) that you specified when configuring
this UBA Bulk Collector.

The trailing dash (-) after <collector_number>

Removes extraneous log messages from your
view. That is, the trailing dash guarantees
that the command displays only those
messages generated by your application. The
first set of messages relate to syntax checks.

The following table identifies some events to watch for during the syntax

check:

Event

Meaning

The UBA application starts successfully, but
then stops executing.

Typically, this event occurs because of a
licensing issue.

The bulk adapter design file might be
corrupted.

This event causes a syntax error before the
UBA application connects to the database.

The UBA application connects to the
database.

This event causes a message similar to the
following example to display: DB_CONNECT
Connecting to <sid> as <user> If you see
this database connection message without
prior errors, the UBA application has passed
the syntax check.

7. Run the bulk inventory profile. The UBA application handles the inventory and
metrics according to the instructions provided in the technology pack design
file or files. The UBA application inserts the created elements, subelements, and
metrics into the database. However, the UBA application does not handle the
grouping of these elements and subelements. To handle the grouping of the
elements and subelements that were inserted into the database, UBA
technology packs supply a bulk inventory profile. This bulk inventory profile is
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automatically created when the pack is installed. Bulk inventory profiles use
the following name syntax: bulk_N where:

Syntax item Meaning

bulk_ Identifies this as a bulk inventory profile for
a UBA technology pack.

N Specifies the collector number (for example,
100) that the user specified when
configuring this UBA Bulk Collector.

You must use the Inventory Tool to run a bulk inventory profile. To run the

bulk inventory profiles for this technology pack, perform the following steps:

a. In the command window where you loaded the DataMart environment,
change your working directory to $PYMHOME/bin (/opt/datamart/bin, by
default) on the DataMart server.

b. Invoke the DataMart GUI: $ pvm

c. Click Inventory Tool in the Resource tab. The Inventory Tool window
appears. This window displays a list of the existing inventory profiles on
the Configuration tab. The names of the inventory profiles to run are
bulk N1 and bulk N2, where N1 and N2 are the collector numbers
configured for this pack.

d. On the Configuration tab, click on the bulk inventory profiles for this
technology pack and then select Run Profile from the Action menu. The
Live Information tab displays messages about the status of the profiles. See
the IBM Tivoli Netcool Performance Manager DataMart Configquration and
Operation Guide for more information about running an inventory profile.

e. Optional: Every time the UBA technology pack design file creates new
elements, subelements, and metrics, you need to perform the previous steps
to group the elements and subelements. One way to accomplish this task on
a regular basis is to create a cron entry that make use of the inventory
command. The following example shows the cron entries that periodically
perform the grouping operation for the bulk inventory profiles called
bulk_100 and bulk_101:

0 * = » x , /opt/datamart/dataMart.env && inventory -name bulk 100
-action pregrouping -reload -noX

0 » » » x ., /opt/datamart/dataMart.env && inventory -name bulk_100
-action grouping -reload -noX

0 * * * x . /opt/datamart/dataMart.env && inventory -name bulk_ 101
-action pregrouping -reload -noX

0 * = » » , /opt/datamart/dataMart.env && inventory -name bulk 101
-action grouping -reload -noX

See the IBM Tivoli Netcool Performance Manager Command Line Interface Guide
for more information about the inventory command.

8. Deploy reports. After the technology pack installation completes, the rules for
the new device are automatically loaded into the database. The inventory
process uses those rules to group elements and subelements. You must
manually deploy (auto-group) the reports by associating them with groups in
the NOC Reporting tree in the DataMart Resource Editor.To deploy the
Alcatel-Lucent SAM 5620 LogToFile Technology Pack reports, follow these
steps:

a. Open the Tivoli Netcool Performance Manager DataMart Resource Editor.
b. Click the ReportSEGroup tab.

c. Move the cursor to the left pane and scroll up to select any group under the
SUB-ELEMENTS->NOC Reporting tree.
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d. Right-click and select the AutoGrouping option from the menu. The
AutoGrouping option places the reports in dynamically generated groups
created during inventory.

e. Click Yes to continue.

f. Click Close to exit the message box, or click Details to view a description of
any errors.

g. Optional: You can also deploy reports on a regular basis by creating a cron
entry that makes use of the inventory CLI command and the
-reportGrouping option. This option instructs the inventory command to
run the report grouping rules and update the deployed reports stored in the
database. Report grouping rules must first have been created before this
option can be used. For information on creating report grouping rules, see
the IBM Tivoli Netcool Performance Manager: DataMart Configuration and
Operation Guide. The following example shows a cron entry that periodically
performs the deploy report operation:

0 » = x » . /opt/datamart/dataMart.env && inventory -noX
-reportGrouping

See the IBM Tivoli Netcool Performance Manager: Command Line Interface Guide
for more information about the inventory command.

Verifying resources

Use the Tivoli Netcool Performance Manager DataMart Resource Editor to
determine whether the technology pack resources (elements, subelements,
properties, and so on) were successfully discovered and created in the database
during inventory.

See the IBM Tivoli Netcool Performance Manager DataMart Configuration and Operation
Guide for information about using the DataMart Resource Editor.

Configuring Secure File Transfer support in Alcatel-Lucent 5620 SAM
LogToFile 2.1.0.0 Technology Pack
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If you want to use Secure File Transfer, OpenSSH must be configured for
key-based authentication when you connect from the Tivoli Netcool Performance
Manager account on the client (the host that is running the Tivoli Netcool
Performance Manager process that must use SFIP) to the account on the server. In
addition, the host keys must be established such that the host key confirmation
prompt is not displayed during the connection.

UBAs in Alcatel-Lucent 5620 SAM LogToFile 2.1.0.0 Technology Pack can connect
to the DataStage server by using FTP alone. If you want to use SFTP support, use
the steps that are described in the following technical noteiﬁttp:/ / |
bublib.boulder.ibm.com /infocenter/tivihelp /v8r1 /topic/|
com.ibm.netcool_proviso.doc_4.4.2/tech_notes/NetcoolProvisoTechNote-sftp.pdf]

For more information about SSH login without password, see
www.linuxproblem.org /art_9.html|
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Chapter 5. Upgrading the Alcatel-Lucent 5620 SAM 2.12.0.0
Technology Pack to Alcatel-Lucent 5620 SAM LogToFile

2.1.0.0

Upgrade the Alcatel-Lucent 5620 SAM 2.12.0.0 Technology Pack to Alcatel-Lucent
5620 SAM LogToFile 2.1.0.0.

About this task

To upgrade the Alcatel-Lucent 5620 SAM 2.12.0.0 Technology Pack to
Alcatel-Lucent 5620 SAM LogToFile 2.1.0.0:

Procedure

© Copyright IBM Corp. 2013

. Stop the data channel:
a.
b.

Start a terminal emulator on the DataChannel server

Run the dcemd command to stop all the DataChannel applications:
$ dcemd stop all

Run the dcemd command to release all daemons that are running in the
DataChannel:
$ dcemd forget all

Run the following command to find the process identifiers (pids) that are
associated with the DataChannel visual processes:
$ findvisual

Run the following commands to stop each DataChannel visual process:

$ ki1l -9 <cnsw_pid>
$ ki1l -9 <logw_pid>
$ ki1l -9 <amgrw_pid>
$ ki1l -9 <cmgrw_pid>

. Start the Topology Editor, and delete UBA.1.100 and UBA.1.101. To do this,

follow these steps:

a.

Open the Topology Editor, and click Topology > Open existing topology
to load existing topology from database.

In the Logical View, select the UBA collector, right click and Remove
Collector channels.

Repeat for the same step for all existing UBA collectors in system.
Click Topology > Save Topology.

e. Click Run > Run Deployer for Uninstallation to deploy the topology that

you configured.

. Save the topology, and run the deployer to complete the uninstallation.

. Delete the following directories and remove or create a backup of the data

channel directories that are at /opt/proviso/datachannel:

/opt/proviso/datachannel/bin
rm —rf * visual

/opt/proviso/datachannel/state
rm —rf *pid
/opt/proviso/datachannel/log
rm —rf *log
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5. Install the Alcatel-Lucent 5620 SAM LogToFile 2.1.0.0 Technology Pack. For
more information, see [“Installing the technology pack by using the
[launchpad” on page 17|

Copy the core patches to/opt/proviso/datachannel/state.
Start the Topology Editor and load the technology pack from the JAR file.
Configure UBA.1.100 and UBA.1.101.

Set the APP.FILE_PERIOD parameter value same as the data file polling time.
For example, if the data file polling is at the cycle of every 5 Minutes, set the
value to 300.

© ®» N

10. Save the topology.
11. Run the deployer to complete the installation.
12. Start the Request Editor, set to inactive, and then save.

13. Update the polling time to 5 Minutes or 15 Minutes, set to active, and then
click Save.

14. Run the following commands to restart each DataChannel visual process:

$ cnsw
$ logw
$ amgrw
$ cmgrw

15. Run the dcemd command to start all the DataChannel applications: .
$ Dcemd start all
16. Compile the uba profiles.

17. Run the auto-grouping again after the full dump process is completed for the
first time.
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Chapter 6. Installation and configuration of IBM InfoSphere
Information Server and related components

Describes how to install and configure the various IBM InfoSphere Information
Server and other related components that are required for Alcatel-Lucent 5620
SAM LogToFile 2.1.0.0 Technology Pack such as:
Components

* IBM InfoSphere Information Server 8.7

* IBM InfoSphere Information Server Client 8.7

* Apache ActiveMQ 5.5.1

Planning for IBM InfoSphere Information Server software installation

Ensure that hardware and software requirements for the product modules that you
want to install are met on your computers.

For latest information about the installation requirements, see these resources:

* |System Requirements|

* |[Release Notes

Installing IBM InfoSphere Information Server 8.7 software

IBM® InfoSphere™ Information Server includes a set of collaborative product
modules and components that you can distribute across multiple computers. This
section describes how to install and remove the InfoSphere Information server and
client software .

Installing IBM InfoSphere Information Server by using the
wizard (graphical mode)

You can run the installation program locally by using a web browser on the target
computer. Alternatively, you can use a web browser on any system in a distributed
environment.

Before you begin

During the initial installation session, install all of the product modules that you
plan to use either now or in the future. If you install only some of the product
modules now, and then install fixes and service packs, you might need to reinstall
the fixes and service packs if you add product modules later.

About this task

When you first start the installation program, it presents a non-graphical interface.
The program starts a self-contained web server on the computer. You can then start
a web browser on the computer or on a remote computer and access the graphical
interface. After you enter your settings in the wizard pages, the program stores
your settings in a response file. If you run the installation program again, you can
load your settings from this file into the program instead of entering them again.
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Procedure

1. Extract the InfoSvr_v8.7_Linux64.tar.gz file to a location of your choice. The
installation media appears in the is-suite directory.

2. Change to the is-suite directory and run the installation program as root
user by using the following command:

./setup [-verbose]

The -verbose option is optional. The option causes the installation program to
display log messages to the console and also write them to the log file. If the
-verbose option is not specified, log messages are written to the log file only.
Several messages are displayed. The program then displays a message about
how to access the installation wizard:

======> Enter one of the following URLs to your web browser to begin the installation process:
http://localhost:8080/ISInstall
https://localhost:8443/1SInstall

3. Open a web browser on the computer or on a remote computer, and navigate
to one of the addresses that is listed in the messages from starting the
installation program.

4. Select a language from the menu for the installation program to use and click
Login. This selection applies only to this installation session. Later in the
installation process, you can select the language to apply to the InfoSphere
Information Server installation.

5. Click System > System Firewall > Disable Firewall (for both Firewall and
SELinux Setting ) to disable the firewall.

6. Click Next on the prompts in the installation program to continue to install
the product. The installation program runs an Early Requirements Check to
ensure that your installation is configured correctly as shown in the figure:
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The page displays the results of the check as PASSED or FAILED. If the check
found issues that might cause problems with the installation, it is marked as
WARNING on the page.

For more information about resolving the failed installation prerequisites, see
http: / /pic.dhe.ibm.com/infocenter /iisinfsv /v8r7 /topic/|
lcom.ibm.swg.im.iis.productization.iisinfsv.install.doc/ topics /|
wsisinst_install_prereq_check_fails.html|

7. When all early requirements checks are passed, click Next.

8. Click the default path where you want to install the Information Server in the
Installation directory field, and then click Next. By default, the installation
directory is /opt/IBM/InformationServer.

9. Click New installation in the "Installation Type Selection" page, and then click
Next.

10. Click to select all the tiers in the "Tier Selection" page and click Next.

11. Enter the password for the root user in the Password for root field and click
OK.

12. Click Select All in the "Product Selection" page and click Next.

13. Accept the terms and conditions in the "Software License Agreement" page
and click Next.

14. Select the IBM InfoSphere DataStage (Select this edition to develop parallel
and server jobs) and IBM InfoSphere DataStage Balanced Optimization
check box in the "IBM InfoSphere DataStage Installation Options" page and
click Next.

15. Click Next in the "High Availability Server Cluster Configuration" page as
there is no support for High Availability Server in the present context.
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16.

17.

18.

19.

20.

21.

22.

23.

24.

25.

26.

27.

28.

29.
30.

31.

Click Install WebSphere Application Server in the "Application Server
Options" page and click Next.

Click Browse to select the installation directory for the WebSphere Application
Server. By default, the installation directory is /opt/IBM/WebSphere/AppServer.

Select the Customize WebSphere Application Server profile ports check box
in the "IBM WebSphere Application Server Installation”" page, and then click
Next.

Verify that each port number is unique in the "IBM WebSphere Application
Server Profile Ports Assignment" page and click Next.

Enter the Application Server administrator user name and password and click
Next.

Enter the InfoSphere Information Server administrator user name and
password and click Next.

Click Install IBM DB2 9.7 Enterprise Server Edition to install and create the
databases within DB2 and click Next.

Click Browse to specify the directory where you want to install the DB2
database system. By default, the installation directory is /opt/IBM/db2/v9. If
you are configuring an existing DB2 instance, specify the location of the
existing DB2 database system installation and the port number for connecting
to the instance.

Click Create a user as an instance owner in the "IBM DB2 Instance User"
page and enter the user information, and then click Next. Also, enter a port
number for the new instance. If you created an instance owner account before
starting the installation program, click Existing user and enter the DB2
instance owner name. You receive a conformation after the user is created.
Click OK.

Click Create a new user as a fenced user in the "DB2 Fenced User
Information" page and enter the DB2 fenced user information and then click
Next. If you created the fenced user name before starting the installation
program, click Existing user and enter the DB2 fenced user name. Any fenced
user-defined functions (UDFs) and stored procedures that are run under this
user and group.

Click Create the user as administrator user in the "DB2 Administrator User
information" page and enter the administrator user information, and then click
Next

Enter the metadata repository owner information, database name, database
instance name, and database location in the "Metadata Repository
Configuration” page, and then click Next.

Enter the metadata repository owner information, database name, database
instance name, and database location in the "Staging Area Configuration"
page, and then click Next. The default agent port settings that are displayed
in the "IBM InfoSphere Information Server Agent Ports Configuration" page
work in most configurations.

Click Next.

Enter the two TCP/IP port numbers to use for the IBM InfoSphere DataStage
and QualityStage job monitor in the "Job Monitor Ports Configuration" page,
which takes snapshots of job performance. The job monitor uses one port to
request job information and the second port to report job information. The
default port settings are acceptable in most configurations. The default settings
are 13400 and 13401 for the first and second ports.

If you want to install another engine instance on a computer that has an
existing engine instance, enter the unique tag information for the engine in the
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ITAG field and port number in the RPC port number field. If you are not
installing multiple engine instances on the same computer, you can skip this
step.

32. Click Create user as the IBM InfoSphere DataStage Administrator in the
"IBM InfoSphere DataStage Administrator" page and enter the user
information, and then click Next. If you created the DataStage administrator
user name before starting the installation program, click Existing user and
enter the user name.

33. If you have existing jobs that use SAS, enable a legacy SAS configuration and
select the SAS that you want to configure and click Next. If your existing jobs
do not use SAS or you are doing a fresh installation, ignore this step and click
Next.

34. Click Add Projects and enter the InfoSphere DataStage projects to create in
the "IBM InfoSphere DataStage Projects”" page and click Next. You must create
at least one project during installation. By default, a project by name dstagel
is created. The installation program runs a system requirements check for the
selections that are made. The page displays the results of the check as PASSED
or FAILED. If the check found issues that might cause problems with the
installation, it is marked as WARNING on the page. To resolve the issues that
are found during this check, see |http:/ /publib.boulder.ibm.com/infocenter /|
iisinfsv /v8r7 /topic/com.ibm.sweg.im.iis.productization.iisinfsv.install.doc /|
topics/wsisinst_install_prereq_check_fails.htm]]

35. Click Next if all the system requirements checks are passed. If there are any
warnings that are displayed, you can select the Ignore "WARNING" items
and continue check box, and then click Next.

36. Click Install IBM InfoSphere Information Server and save my settings in a
respaonse file in the "Response File Review" page and click Next to begin the
installation.

Or, enter a name and location for the response file in the Response file
location field in the "Response File Review" page. By default, it is:
/opt/IBM/InformationServer87/response.txt and click Next to begin the
installation. You can choose to cancel the installation and use the saved
response file in a later session. The "Post Installation Summary for Current
Computer” page is displayed that contains the product, tiers, and product
components that you installed, and information about how long the
installation program ran and whether the installation was successful.

37. Click Install.
38. C(Click Finish.

What to do next

If you face any installation problems, resolve them with this installation
troubleshooting information from here:

http:/ /publib.boulder.ibm.com/infocenter/iisinfsv /v8r7 /topic/ |
com.ibm.swe.im.iis.productization.iisinfsv.install.doc/topics /|
wsisinst_ts_is_container.html|

You can find more troubleshooting information in the information centers and
customer support technical notes for various product modules and components.
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Installing IBM InfoSphere Information Server client by using
the wizard (graphical mode)

You can run the installation program locally by using a web browser on the target
computer. Alternatively, you can use a web browser on any system in a distributed
environment.

Before you begin

During the initial installation session, install all of the product modules that you
plan to use either now or in the future. If you install only some of the product
modules now, and then install fixes and service packs, you might must reinstall the
fixes and service packs if you add product modules later.

About this task

When you first start the installation program, it presents a non-graphical interface.
The program starts a self-contained web server on the computer. You can then start
a web browser on the computer or on a remote computer and access the graphical
interface. After you enter your settings in the wizard pages, the program stores
your settings in a response file. If you run the installation program again, you can
load your settings from this file into the program instead of entering them again.

Procedure
1. Extract the Infosvr_Client_v8.7_Win.zip file to a location of your choice. For
example, C:\is-client

2. Double-click the installation program, setup.exe. Several messages are
displayed. The program then displays a message about how to access the
installation wizard:

======> Enter one of the following URLs to your web browser to begin the installation process:
http://Tocalhost:8080/ISInstall
https://localhost:8443/ISInstall

The installation program automatically starts the default web browser on the
local computer to display the graphical interface.

3. Select a language from the menu for the installation program to use and click
Login. This selection applies only to this installation session. Later in the
installation process, you can select the language to apply to the InfoSphere
Information Server installation.

4. Click System > System Firewall > Disable Firewall to disable the firewall.

5. Click Next on the prompts in the installation program to continue to install

the product. The installation program runs an Early Requirements Check to
ensure that your installation is configured correctly as shown in the figure:
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v Getting Started

+ Firewsll Requirement

> Early Requirements Check
Installation Directory
Installation Type Selection
Product Selection
Requirements Check
Response File Review
Summary
Instsllstion
Installation Complete

BM InfoSphere Information Server

Early Requirements Check

The dlient installation program is checking that the target computer meets minimum system requirements, In the Results list, double-click line
items to view mare infarmatinn.

Requirement Check Result Details

Z Description
Checking ! B
_ Ensure that the Microsoft NET Framework 4 is installed. Presions
Results Mest
Status Close
PASSEC
passEr  otatus
PASSEC | FAILED
PASSEC
PASSEC
PASSEC
PASSEC
pasSEC  Resolution for failure
PASSEC | Please do the following steps:
P&SSEC | a) Download the Microsort JMET Framework 4 available at httpifiniv.microsoft.com/download/en/details.aspxfid=17718

ST | bl Install the JMNET Framework 4
) Reboot the machine

d) Restart the Information Server installation.

Sawe Report.,

Check Again

Cancel ‘

The page displays the results of the check as PASSED or FAILED. If the check
found issues that might cause problems with the installation, it is marked as
WARNING on the page.

6. When all early requirements checks are passed, click Next.

7. Click Browse to select the directories where you want to install the
Information Server in the Installation directory field, and then click Next. By
default, the installation directory is C:\IBM\InformationServer

8. Click New installation in the "Installation Type Selection" page, and then click
Next.

9. Click Select All in the "Product Selection" page and click Next.

10. Accept the terms and conditions in the "Software License Agreement" page
and click Next.

11. Enter the port numbers in the "Metadata Interchange Agents Ports
Configuration" page. The default port numbers are as shown in the figure:
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¥+ Getting Started Metadata Interchange Agent Ports Configuration

¥ Firewall Requirement
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Installation

Installation Complete

Metadata Interchange Agent shutdown port
The port onwhich the Metadata Interchange Agent waits for requests to shut down,

13978
Metadata Interchange Agent AJP port

The port onwhich the Apache JServ Protocol ()P connector waits for incoming connections.

19979

3 Cancel

12. Select the Create desktop shortcuts check box in the "Desktop shortcut
creation option" page and click Next. After the installation program has
collected your selections, it runs another, more detailed system requirements
check in the "System Requirements Check" page that is based on your
selections. During this check, it analyzes your computer resources and file
system to determine whether the installation is likely to succeed.

13. Click Next if all the system requirements checks are passed. If there are any
warnings that are displayed, you can select the Ignore "WARNING" items
and continue check box, and then click Next.

14. Specify a name and location for the response file in the Response file location
field in the "Response File Review" page. By default, it is:
C:\IBM\InformationServer\response.txt. You can choose to cancel the
installation and use the saved response file in a later session.

15. Click Install IBM InfoSphere Information Server and save my settings in a
response file in the "Response File Review" page and click Next. A
"Preinstallation Summary for the Current Computer" page is displayed that
contains the product, installation directory, tiers, and disk space information.

16. Click Install. When the installation process is complete, a "Post Installation
Summary for the Current Computer" page is displayed that contains the
product, tiers, and product components that you installed, and information
about how long the installation program ran and whether the installation was
successful.

17. Click Finish.

What to do next

If you face any installation problems, resolve them with this installation
troubleshooting information from here:
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You can find more troubleshooting information in the information centers and
customer support technical notes for various product modules and components.

Verifying and testing the installation

After you install and configure InfoSphere DataStage and InfoSphere
QualityStage™, test the installation by logging in to the Administrator and Designer
clients.

Installing Apache ActiveMQ

Apache ActiveMQ is an open source software that is customized and bundled with
file. Apache ActiveMQ is responsible for buffering message for J]MS Poller that is
backed by disk storage. It is an interface to JMS poller to pass messages.

About this task

Apache ActiveMQ must be installed on the same server where the IBM InfoSphere
Information Server server is installed.

Procedure

1.

Download the tnpm-apache-activemg-5.5.1-bin.tar.gz file to the server where
the InfoSphere Information Server is installed.

As root user, extract the file to /opt directory by using the following command:
tar zxvf /IBM/InformationServer/tnpm-apache-activemg-5.5.1-bin.tar.gz
Copy the activemq.rc file from the opt/apache/activemq/5.5.1/bin directory.

Add activemq.rc file as a system service by linking the file in /etc/init.d by
using the following commands:

In-s opt/apache/activemq/5.5.1/bin/activemq.rc
/sbin/chkconfig --add activemqg.rc
/sbin/chkconfig activemg.rc on
/sbin/chkconfig service active

Start Apache ActiveMQ by using the following command:

./activemg.rc start

Stop the Apache ActiveMQ by using the following command:

./activemg.rc stop

To verify that ActiveMQ installation is successful, do one of the following steps:

a. Log in to the server where ActiveMQ is installed by using the following
command:

http://<host_name>:8161/admin/

If the web page opens as shown in the figure, the installation is successful:
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b. Or
To check that the ActiveMQ service is running, give the following
command:

ps -ef |grep active

Proviso collector mapping

Before you begin

Ensure that all dependencies are installed and kernel parameters updated
accordingly.

* To check the kernel parameter, use the following command:

C/sbin/sysct] -a | grep <PARAMETER> )

* To update the kernel parameter, use the following command:

(/sbin/sysct] -w <PARAMETER>="<VALUE>" )

Permanently, change the kernel parameter by modifying the /etc/sysctl.conf
file.

Procedure

1. Install Oracle 11g client. For more information about Oracle client installation,
see |http:/ /publib.boulder.ibm.com /infocenter/tivihelp /v8rl/topic/|
[com.ibm.tnpm.doc/oracle/ctnpm_ora_installoral0gclient html]

Note: The Oracle client should be installed to all servers hosting Tivoli Netcool
Performance Manager components, except for the server hosting the Tivoli
Netcool Performance Manager database.

2. Configure the tnsname.ora file that is located in $ORACLE_HOME/network/admin to
connect to Tivoli Netcool Performance Manager wireline.

3. Update the DataStage dsenv file that is located in $DS_HOME. By default, the
$DS_HOME is /opt/IBM/InformationServer/Server/DSEngine. For more
information about configuring the dsenv file, see [“Configuring the dsenv file”|
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4. Create a soft link to 1ibccorallg.so by using the following command:

cd $ORACLE_HOME/1ib
Tn -s /opt/IBM/InformationServer/Server/StagingArea/Installed/OracleConnector/Server/linux/1ibccorallg.so
Ticccorallg.so

Typically, The Tibccorallg.so is located in the following path:
/opt/IBM/InformationServer/Server/StagingArea/Installed/OracleConnector/
Server/1inux/1libccorallg.so.

5. Update the $DSHOME/dsenv as dsadm user. The following parameters must be
included:

export ORACLE_HOME

export TNS_ADMIN

update LD_LIBRARY_PATH to include $APT_ORCHHOME/bin, $ORACLE_HOME/1ib and $ORACLE_HOME/rdbms/1ib
update PATH to include $APT_ORCHHOME/bin and $ORACLE_HOME/1ib

export ORACLE_BASE

update LIBPATH to include $ORACLE_HOME/rdbms/1ib & $ORACLE_HOME/1ib

6. Run the install.liborchoracle script by using the following steps:
a. Source the environment by using the following commands:

export DSHOME=/opt/IBM/InformationServer/Server/DSEngine
export APT_ORCHHOME=/opt/IBM/InformationServer/Server/PXEngine

b. Run the install.liborchoracle script by using the following command:

(:/opt/IBM/InformationServer/Server/StagingArea/Instal1ed/Px0rac1e/1nsta11/1nsta11.1iborchorac1 :)

7. Restart the DataStage as root by using the following commands:

./ds.rc stop
./ds.rc start
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Chapter 7. Configure the InfoSphere Information Server
components

Describes the configuration tasks.

Opening the IBM InfoSphere Information Server web console

Use the InfoSphere Information Server web console to manage security, view
scheduled tasks, work with reports, or perform tasks that are related to IBM®
InfoSphere® Business Glossary or the Information Services catalog.

Before you begin

To access the web console, determine the URL to use, configure your browser, and
navigate to the console window.

About this task

The URL for the IBM® InfoSphere® Information Server web console differs
depending upon the IBM WebSphere® Application Server communication protocol
and configuration. The syntax of the URL is as follows:
protocol://host:port/ibm/iis/console

protocol is the communication protocol: either http or https. host and port differ
depending upon the communication protocol and WebSphere Application Server
configuration (clustered or non-clustered).

For example, in a configuration where clustering is not set up, the HTTPS URL
might be:
https://<myhost.example.com>:9443/ibm/iis/console

Configuring web browser to open the IBM InfoSphere Information
Server web console

The IBM® InfoSphere® Information Server web console is supported by both
Microsoft Internet Explorer and Mozilla Firefox. You must do these steps in your
preferred web browser before you use the IBM InfoSphere Information Server web
console.

About this task

* For information about supported browsers, see the InfoSphere Information
Server system requirements at |http://www-01.ibm.com/software/data/ |
[infosphere/info-server/overview /requirements.htmi|

e For more information about IBM InfoSphere Information Server, see

http:/ /publib.boulder.ibm.com/infocenter /iisinfsv /v8r7 / topic /|

com.ibm.swg.im.iis.found.moz.rc.common.doc/ topics /|

iisinfsrv_mcom_overview.html|

* Determine the URL to use as described in [“Opening the IBM InfoSphere]
[[Information Server web console.”|

» If HTTPS is enabled in the URL, follow the browser prompts to accept the
certificate and proceed to the login page.
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Procedure

1. Open a web browser, and navigate to the console. The URL to use depends
upon the IBM WebSphere Application Server communication protocol and
configuration in use.

2. Type your user name and password.
3. Click OK to open the Home tab.

Configuring Microsoft Internet Explorer to open the IBM
InfoSphere Information Server web console
Procedure
1. Enable JavaScript:
a. Click Tools > Internet Options .
b. On the Security tab, click Custom Level.

C. In the Security Settings window, select Scripting > Active Scripting >
Enable.

2. Set the browser to accept cookies for the InfoSphere Information Server host
site.

a. Click Tools > Internet Options.
b. On the Privacy tab, click Sites.
c. In the Address of Web site field, enter the InfoSphere Information Server

host name.
d. Click Allow.
e. Click OK.

3. Enable pop-up windows for the URL of the IBM InfoSphere Information Server
web console:

a. Click Tools > Pop-up Blocker > Pop-up Blocker Settings or turn off the
pop-up window blocker.

b. If you selected the settings, type the URL and click Add.
4. Specify that the pages are refreshed every time that you visit the site:

a. Click Tools > Internet Options and on the General tab, click Settings.
Select Settings in the Browsing history section.

b. Select Every time I visit the webpage or Automatically and click OK.

5. Optional: Disable the display of friendly HTTP error messages. To do this,
follow these steps:

a. Click Tools > Internet Options.

b. On the Advanced tab, clear Browsing > Show friendly HTTP error
messages.

Configuring Mozilla Firefox to open the IBM InfoSphere
Information Server web console
Procedure
1. Enable JavaScript:
a. Click Tools > Options in the Content tab.

2. Set the browser to accept cookies for the InfoSphere Information Server host
site.

a. Click Tools > Options.
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b. On the Privacy tab, click the Accept cookies from sites option or click
Exceptions and add the site to the allowed site list by entering the host
name and click Allow.

3. Enable pop-windows for the URL of the Web console.
a. Click Tools > Options.
b. Select the Contents tab and either clear the Block pop-up windows option

or click Exceptions and add the site to the allowed list by entering the host
name and click Allow.

Configuring the dsenv file

For some ODBC connections, plug-ins, and connectors, and for interactions with
external applications such as IBM WebSphere MQ, you must add environment
variables to enable interactive use of ODBC drivers to make a connection to an
ODBC data source. IBM InfoSphere DataStage inherits the correct environment for
ODBC connections.

Before you begin

You must be logged in as an InfoSphere DataStage administrator with the
operating system credentials on the server for the InfoSphere DataStage
administrator.

Back up the dsenv file before you edit it.
About this task

The dsenv file contains a series of shell arguments that are used when the engine
starts. Interactive users, other programs, and scripts can use the dsenv file. For a
connection that uses a wire protocol driver, you do not have to modify the dsenv
file.

Procedure

1. Edit the dsenv file. The file is in $DSHOME/DSEngine, where $DSHOME identifies the
InfoSphere DataStage installation directory. The default directory
is/opt/IBM/InformationServer/Server/DSEngine.

2. Specify the following information in the dsenv file:
* Environment variables for the database client software
* Database home location
* Database library directory

Operating system Library path environment variable

Linux LD_LIBRARY_PATH

The following examples show typical entries for commonly used databases. The
entries vary slightly depending on your operating system. For more
information, see the data source documentation.

e QOracle
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ORACLE_HOME=Oracle Home

export ORACLE_HOME

TNS_ADMIN=$0RACLE_HOME/network/admin

export TNS_ADMIN

export PATH=$ORACLE_HOME/bin:$PATH
LD_LIBRARY_PATH=$LD_LIBRARY_PATH:$ORACLE_HOME/1ib:$ORACLE_HOME/rdbms/1ib

« DB2® Version 9.5

e
DB2DIR=/opt/I1BM/db2/V9.5
export DB2DIR
DB2INSTANCE=db2inst1
export DB2INSTANCE
INSTHOME=/export/home/db2inst1l
export INSTHOME
PATH=$PATH: $INSTHOME/sq11ib/bin: $INSTHOME/sq11ib/adm: $INSTHOME/sq11ib/misc
export PATH
LD LIBRARY_PATH=$LD LIBRARY_PATH:$INSTHOME/sql1ib/1ib
export LD_LIBRARY_PATH
THREADS_FLAG=native
\?xport THREADS_FLAG

3. Save your changes.

4. |“Stopping and starting the IBM InfoSphere Information Server server engine”|

on page 56.|

Creating users in the IBM InfoSphere Information Server web console

You must create a user for each person that must log in to InfoSphere Information
Server.

About this task

Ensure that you have suite administrator authority. To create a user, follow these
steps:

Procedure

1. In the IBM InfoSphere Information Server web console as wasadmin user, click
the Administration tab.

2. In the Navigation pane, select Users and Groups > Users.
3. In the Users pane, click New User.

4. In the Create New User pane, provide information about the user. Give the
following information:

Option Description

User name dsadm.

Note: You must create a dsadm user. The
dsadm user is required for all operations on
DataStage job in Alcatel-Lucent 5620 SAM
LogToFile 2.1.0.0 Technology Pack.

Password Give the same password as you set for dsadm
UNIX user.
First/Last Name dsadm

5. In the Roles pane, specify all roles.

6. In the Suite Component pane, select whether the user has any suite component
roles. To log in to any of the product modules, a user must have the suite user
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role. Also, add at least one suite component role for each suite component that

you want the user to access. For example, if you are creating a user that will

access IBM InfoSphere Information Analyzer, you must assign the suite user
role, and also the Information Analyzer Project Administrator, Data
Administrator, or User role.

Link thedsadm user to Server Engine by using these steps:
a. Expand Domain Management from Navigation pane.
Click Engine Credentials.

Select the server.

Open Configuration.

®ao0o0oT

its engine option.
f. Click Save and Close.

Select the Share User registry between Infosphere Information Server and

8. Click Save and Close to save the user information in the metadata repository.

Configuring the DataStage job for Secure File Transfer support
About this task

To add Secure File Transfer support for DataStage job, follow these steps:

Procedure

1. In the IBM InfoSphere DataStage and QualityStage Designer, click the Job
Properties button, and then click the Parameters tab.

2. Change the default value for the SECURE_FILE_TRANSFER to TRUE.

3. Create the SSH private key file by name sshkey_fiTe.

4. Copy the SSH private key file to this location:
/opt/IBM/InformationServer/Server/Projects/UDM/udm/cfg/sshkey file

5. Or, link the sshkey_file to the target private key file by using the following

commands as dsadm:

$ pwd
/opt/IBM/InformationServer/Server/Projects/UDM/udm/cfg
$ 1s -1 sshkey file

Trwxrwxrwx 1 dsadm dstage 23 Nov 7 21:47 sshkey file -> /home/dsadm/.ssh/id_
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Chapter 8. Deploying Alcatel-Lucent 5620 SAM LogToFile
2.1.0.0 DataStage jobs

You can design InfoSphere DataStage Administrator jobs by using the IBM
InfoSphere DataStage and QualityStage Designer client.

The Designer client gives you the tools that you need to create jobs that extract,
transform, load, and check the quality of data. The Designer client is like a
workbench or a blank canvas that you use to build jobs. The Designer client has a
palette that contains the tools that form the basic building blocks of a job:

 Stages connect to data sources to read or write files and to process data
* Links connect the stages along which your data flows.
* Annotations provide information about the jobs that you create.

The Designer client uses a repository where you can store the objects that you are
creating as part of the design process. These objects can be reused by other job
designers.

Jobs and their associated objects are organized in projects. DataStage
administrators create projects using the Administrator client. When you start the
Designer client, you specify the project that you will work in, and everything that
you do is stored in that project.

When your job designs are finished they are run in the Director client. No data is
moved or transformed until you actually run the job. When you start the Director
client, you specify the project that contains the jobs to run.

Starting the Designer client

The Designer client is the tool that you use to set up your project, and to create
and design your job. The Designer client provides the tools for creating jobs that
extract, transform, load, and check the quality of data. The Designer client is like a
workbench or a blank canvas that you use to build jobs.

Before you begin

The Designer client palette contains the tools that form the basic building blocks of
a job:
* Stages connect to data sources to read or write files and to process data.

* Links connect the stages along which your data flows.

The Designer client uses a repository in which you can store the objects that you
create during the design process. These objects can be reused by other job
designers.

Procedure

1. Select Start > Programs > IBM InfoSphere Information Server > IBM
InfoSphere DataStage and QualityStage Designer.

2. In the "Attach to Project” window, type your user name and password.
3. Select your project from the Project list, and then click OK.
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4. Click Cancel to close the "New" window.

Setting up a project

A project is a container that organizes and provides security for objects that are
supplied, created, or maintained for data integration, data profiling, quality
monitoring, and so on. Projects are a method for organizing your work. You define
data files, define stages, and build jobs in a specific project. A project can contain
one or more jobs. Any of the metadata objects in a project (such as jobs or table
definitions, for example) can be grouped logically and organized into folders. You
can define security at the project level. Only users who are authorized for your
project can access your jobs.

About this task

Procedure

1. Login to the Administrator client as dsadm.

2. Click the Projects tab in the Administrator window.
3. Click the Add button.
4

. Enter the project name in the Name field. Enter the project name as UDM. It is
automatically appended to the default location for the new project. You cannot
add a project to a location that already exists.

5. To change the default location, enter a new location in the Location on host
field, or use the Browse button to select a new location.

6. Optional: If you want the project to be a protected one, select the Create
protected project check box.

7. Optional: If you want to copy the users who can access the new project, and
their roles, from an existing project, select Copy roles from existing project,
and select the project from which to copy from the list.

8. Click OK. You can see the project that you created in the following directory:
/opt/IBM/InformationServer/Server/Projects/UDM

9. Create a directory by name udm inside the project that you created by using the
following commands:

umask 002
mkdir udm

You can install and import the job in this directory.

Extracting the job archive file

Before you begin

Ensure that you have created a project by name UDM and a sub-directory by name

udm inside the project directory. The ds_job_v2.1.0.0.2.dsx is packaged inside the
alcatel_5620_sam_ds_v2.1.0.0_build_2.tar.gz file from the technology pack JAR
file.

Procedure

1. Extract the alcatel 5620 sam ds v2.1.0.0_build _2.tar.gz file in
/opt/IBM/InformationServer/Server/Projects/UDM/udm by using the following
command:

tar zxvf alcatel 5620 sam_ds v2.1.0.0 _build_2.tar.gz
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Open IBM InfoSphere DataStage and QualityStage Administrator on your
desktop.

Log in with the user name and password of an account with the DataStage
and QualityStage Administrator role. For example, dsadm.

Click the Projects tab to list the Projects.
Select the project UDM, and then click Properties.

In the Project Properties window, click Environment. The Environment
Variables window opens.

Expand General and change the value for LD_LIBRARY_PATH variable to:
Jusr/1ib:.:/opt/IBM/InformationServer/Server/Projects/UDM/udm/11ib
This is the path where the compiled custom libraries are located.

Optional: Expand Parallel and change the value for APT_CONFIG_FILE variable
to:

/opt/IBM/InformationServer/Server/Configurations/default.apt

Configure the default.apt file to add the number of DataStage nodes that are
required.

Click OK.

Click Close to save the new project and to exit the InfoSphere DataStage and
QualityStage Administrator.

Importing an IBM InfoSphere DataStage job

You must create a project and then import a job into the project. The project and its
job are created and then imported into the metadata repository by using IBM®
InfoSphere " DataStage® and QualityStage " Designer.

Before you begin

Before you import the ds_job_v2.1.0.0.2.dsx that is available in the technology
pack JAR file, close all the open stages from the previous JAR file. This is not
required on a fresh installation.

Procedure

1.

w

10.

Log in to IBM InfoSphere DataStage and QualityStage Designer as dsadm and
password.

Select your project from the Project list.
Click Jobs in the Repository pane.

Log in with the user name and password of an account with the DataStage
and QualityStage Administrator role. Select the project that you have created
from the Project list. If a New window opens, click Cancel.

Copy the ds_job_v2.12.1.0.dsx file from the/opt/IBM/InformationServer/
Server/Projects/UDM/udm folder.

In the toolbar, click Import > DataStage Components.

In the DataStage Repository Import window, browse to the directory where
you extracted the job files. Select ds_job_v2.1.0.0.2.dsx as the import file.

Select Import selected radio button and Perform impact analysis check box.

Click OK to import the job. You will see the Import load progress window
showing the number of items being loaded.

After the loading is complete, click Jobs > 5620sam > J01main5620sam You
can see the job design flow diagram in the canvas.
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Configuring the DataStage job

Procedure

1. In the IBM InfoSphere DataStage and QualityStage Designer, click Routines >
5620sam > checksum from the Repository pane.

2. Change the Library path for all routines to /opt/IBM/InformationServer/
Server/Projects/UDM/udm/1ib/1ibroutines.so and click Save. This is the path
where the compiles custom libraries are located.

Click Close.

ook w

Repeat step 1 through step 2 for all the routines.

Click the Job Properties button and then click the Parameters tab.

Change the default value for the following parameters:

Option

Description

DS_HOME

/opt/IBM/InformationServer/Server/
DSEngine

DS_WORKSPACE

/opt/1BM/InformationServer/Server/
Projects/UDM

SAM_PRIMARY_SERVER

<sam_primary_server>

SAM_SECONDARY_SERVER

<sum_secondary_server>

For the remaining parameters, accept the default values.

25 YJobs\56205armimain20130114 - Job Properties [ = ||E
General ﬁrameters ! Job contral 1 Dependencies 1 MLS ; Execution | Defaults i
:. | Patametername | Prompt Tupe Drefault Yalue Help T ext
| 1 |D5_HOME DS _HOME String fopt/IBM nformationS erver/Server/DSEngine
| 2 |D5_WORKSFACE DS_WORKSPACE  Shing Aopt/IBM AnformationS erverdS erver/Projects/DEY
| 3 | 5AM_PRIMARY_SEF SAM_PRIMARY_SEF Shing
W o0 SECONDARY | 5AM SECOMDARY |Sting ] EEEEsss——— | E———
| 5 |saM_JMS_PORT  SAM_JMS_FORT  Sting 1099
| B |5AM_USERMAME  SAM_USERMAME  Shing Fam-o
| 7 |5AM_PASSWORD  SAM_PASSWORD  Shing 5E205am!
| 8

| 8 |58M_%ML_OUTDIR  SAM_ML_OUTDIR Shing
| 9 |5AM_MD5_PASSWO GAM_MD5_PASSWI Sting

Sopt/BE20sam,/serverd=ml_output.
c36b8E5125105c462d 347741 40eecl7E

| 10 | SECURE_FILE_TRAM SECURE_FILE_TRA List falze
| 11 | 5AM_FTF_USERNAM SAM_FTP_USERMA Shing zamnadrnin
12 | 5AM_FTP_PASSWOI SAM_FTP_PASSWO Shing BE205 am!
13 |PROVISO_ORA_MAK PROVISO_ORA_MAF Sking P
| 14 | PROVISO_DRA_USE PROVISO_ORA_USE Shing PY_LOIS
15 |PROVISO_ORA_PAS PROVISO_ORA_PAS Sting P
16 |wINDOW_FERIOD ‘WINDOW_PERIOD Integer 300
7 |'wiavE PERIOD WaWE_PERIOD Iteger 300
|18 |'waAlT_DURATION  WAIT_DURATION  Integer 300 I}
P T | (]

Lreate Parameter Set.. I Wiew Faram

‘ Add Parameter Set... ] Add Environment Y ariable. .. '

7. Click OK.

Help

o]

Cancel ]

8. Click File > Exit to close IBM InfoSphere DataStage and QualityStage Designer.
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Configuring the CSV files in the cfg directory

There are four CSV files that you must configure from the cfg directory where the
IBM InfoSphere Information Server server is installed.

You can access the cfg directory from this location:
/opt/IBM/InformationServer/Server/Projects/UDM/udm/cfg

The files that you must configure are as follows:

server_lookup.csv
If you have an auxiliary server, you must enter the IP address and the user
credentials to login to the server in this file.

filter_lookup.csv
If you want to filter some records that are coming from the SAM server,
you can write an expression for the filter criteria in this file. For more
information about this file, see [’Specifying what inventory and metrics to|
lcollect” on page 65

collector_lookup.csv
You can specify the UBAs with their collector IDs that you have in this file.
The UBAs exist in pairs of Performance and Accounting UBAs. For more
information about this file, see [“Specifying what inventory and metrics to)
fcollect” on page 65

collector_mapping.csv
When you want to provision a new element and you have the load
balancing criteria. You can specify the family, IP address of the element
and collector ID it must be mapped to. There are 23 families.

Updating the operator.apt file

An extra configuration step.

Procedure

1. Go to the operator.apt file from this location:
/opt/IBM/InformationServer/Server/PXEngine/etc/operator.apt

2. Edit the operator.apt file to add the following lines:

CSVWriterOp  1ibCSVWriterOperator 1
FeedbackOp  TibWaveOperator 1
ReceiverOp  TibWaveOperator 1
WindowOp TibWindowOperator 1
PerlizeOp libPerlizeOperator 1
CombineOp 1ibCombineOperator 1
AuditOp TibAuditOperator 1
HousekeeperOp 1libHousekeeperOperator 1
XMLChunkerOp 1ibXMLChunkerOperator 1

These are the custom libraries that are specific to Alcatel-Lucent 5620 SAM
LogToFile 2.1.0.0 Technology Pack.
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Enabling the firewall on the IBM InfoSphere Information
Server and WebSphere Application Server

Open and make the TCP ports available through firewall for InfoSphere
Information Server and WebSphere Application Server.

Procedure
1. Activate the firewall on the DataStage server by using the following steps:
a. Click System > Administration > Security Level and Firewall.

b. In the Security Level Configuration window, click Firewall list and select
Enabled.

c. Click the SELinux tab and select Permissive from the SELinux Setting list.
2. Enable the ports for the DataStage server by using the following steps:

a. Log in to https:/<hostname>:<port>/ibm/console. InfoSphere Information
Server web-based client opens.

b. Click Servers > Server Types > Websphere application servers.
C. Select your server name from the Application Server panel.

d. On the Communications section, click Ports. A page that displays the list of
ports opens.

3. Additionally, you must enable all the was.* ports and dsrpc.port port. To do
this, follow these steps:

a. Open the response.txt file and add the port number with this command:

Note: The default location for response.txt file is:
/opt/IBM/InformationServer/Server/Projects

$ cat /opt/IBM/InformationServer/response.txt | grep -i port

A list of ports are displayed in the console.

b. Open the ports with this command:
iptables -I INPUT -p tcp --dport <port_number> -j ACCEPT

c. Enable the ports was.* ports and dsrpc.port port.

d. Save the setting and restart the iptables with these commands:
service iptables save

service iptables restart

e. List the opened ports with this command:
iptables -L

f. Save this setting to a file by using the following command:
iptables-save > /root/ds_firewalls

g. Append the following lines to /etc/rc.local file so that setting is restored
upon restart:

iptables-restore > /root/ds_firewalls

Note: For more information about verifying the network and opening ports,
see

http:/ /publib.boulder.ibm.com /infocenter /iisinfsv /v8r7/ index.isp?topi(::l
%2Fcom.ibm.swg.im.iis.productization.iisinfsv.install.doc%?2Ftopics|
%2Fwsisinst_pln_networks.html|
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Compiling the job

You must compile the job to prepare it to run on your system on the IBM
InfoSphere DataStage and QualityStage Designer.

Before you begin

Ensure that the job named J01main5620sam that you created is open and active in
the job design area.

Procedure
1. Select File > Compile.

Or, click the Compile (E ) button from the toolbar. The "Compile Job"
window opens. As the job is compiled, the window is updated with messages
from the compiler.

2. When the "Compile Job" window displays a message that the job is compiled
successfully, click OK.

Results
The job is now compiled and ready to run. For more information about getting

your jobs ready to run, see |http:/ /publib.boulder.ibm.com/infocenter /iisinfsv /|
[v8r7 / topic/com.ibm.sweg.im.iis.ds.design.doc/ topics/ gettingjobsreadytorun.html|

Running the job

You can use the Director client to run the job and to view the log that the job
produces as it runs. You also use the Designer client to look at the data that is
written by the job.

About this task

You run the job from the Director client. The Director client is the operating
console. You use the Director client to run and troubleshoot jobs that you are
developing in the Designer client. You also use the Director client to run fully
developed jobs in the production environment.

You use the job log to help debug any errors you receive when you run the job.

Procedure

1. In the IBM InfoSphere DataStage and QualityStage Designer, select Tools > Run
Director. The IBM InfoSphere DataStage and QualityStage Director opens. In
the Director client, your job status is compiled, which means that the job is
ready to run.

2. Select your job in the right pane of the Director client, and select Job > Run
Now. Ensure that the job parameters are set correctly.

3. In the "Job Run Options" window, click Limits tab and select No limit in
Warnings pane.

4. Optional: In the "Job Run Options" window, click the General tab, and then
click Record job performance data option to enable performance data.

5. Click Run.
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6. When the job status changes to Finished, select View > Log.

s
Or, click the Log ( = ) button to open the job in log mode.

7. Examine the job log to see the type of information that the Director client
reports as it runs a job. The messages that you see are either control or
information type. Jobs can also have Fatal and Warning messages.

8. Select File > Exit to close the Director client.
What to do next

You see many warning messages at the time of a job start up. These warning
messages can be ignored. These warning are thrown by DataStage checks. But pay
attention to the warnings that you may see while the job is running. These
warning are thrown by alert user. The job invokes a daemon. This daemon is
connected to SAM JMS and directs all the messages to ActiveMQ. The DataStage
job will then read from the ActiveMQ. To check the daemon process, follow these
steps:

1. Go to /opt/IBM/InformationServer/Server/Projects/UDM/udm/1ogs directory.

2. Open the sam-jms-daemon.1og file to see the messages flowing in. By default,
the KeepAlive messages appear every 30 seconds. This time interval can be
configured on the SAM server.

Attention: It is recommended to restart the DataStage job once in every few days.
When you restart the job, a full dump is not triggered.

Viewing the JMS message flow from SAM server in Apache
ActiveMQ

You can view the results of your job execution by opening the Apache AciveMQ
from the Web browser. You can see the J]MS message flow from SAM server in
Apache ActiveMQ.

Procedure

1. Open the Apache ActiveMQ console from the web browser:
http://<Server_IP_Address>:8161/admin/
<Server_IP_Address> is the server where Apache ActiveMQ is installed.
2. Click the Queues tab. You can see the Number Of Consumers, Messages

Enqueued and Messages Dequeued. You can also perform maintenance from
here.

Gracefully shutting down the job

Procedure
1. Go to /opt/IBM/InformationServer/Server/Projects/UDM/udm/bin directory.
2. Run the sendDoneMessage.sh file by using the following command:

cd /opt/IBM/InformationServer/Server/Projects/UDM/udm/bin
./sendDoneMessage.sh

Ideally, when you stop the Job, the daemon process must be running. Check the
status of the daemon by using the following command:

./daemon.sh status

If for some reason the status gives the following output:
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Ve
UDMD_STATUS=STOPPED

UDMD_REASON="daemon no longer running'

DS_DIR=${DS_DIR-/opt/IBM/InformationServer/Server/DSEngine}

SAM_JMSURL1=${SAM_JMSURL1-10.0.0.56}

SAM_JMSURL2=${SAM_JMSURL2-10.0.0.79}

DS_WORKSPACE=${DS_WORKSPACE-//opt/I1BM/InformationServer/Server/Projects/UDM}

SAM_UNIQUE_ID=${SAM_UNIQUE_ID-devds_JOlmain5620sam}

SAM_USERNAME=$ { SAM_USERNAME-sam-o0}

\?AM_PASSWORD=${SAM_PASSWORD—SBZOSam!}

Look at the sam-jms-daemon.log file from the /opt/IBM/InformationServer/
Server/Projects/UDM/udm/Togs directory. You can troubleshoot and start the
daemon manually. For more information about starting the daemon, see
[“Starting the daemon manually”]|

Starting the daemon manually

At the time of job start, it checks whether the daemon process is running or not. If

the daemon is not running, the job starts the daemon. You can run the daemon
manually.

About this task
To run the daemon manually, follow these steps:

Procedure
1. Go to /opt/IBM/InformationServer/Server/Projects/UDM/udm/bin directory.
2. Start the daemon process by using the following command:

./daemon.sh start
STATUS : SUCCESS

3. To check the status of the daemon, use the following command:
./daemon.sh status

The following output is displayed:

UDMD_STATUS=RUNNING

UDMD_REASON="daemon is running'

UDMD_PID=6505

DS_DIR=${DS_DIR-/opt/IBM/InformationServer/Server/DSEngine}
SAM_JMSURL1=${SAM_JMSURL1-10.0.0.56}

SAM_JMSURL2=${SAM_JMSURL2-10.0.0.79}
DS_WORKSPACE=${DS_WORKSPACE-//opt/IBM/InformationServer/Server/Projects/UDM}
SAM_UNIQUE_ID=${SAM_UNIQUE_ID-devds_JOlmain5620sam}

SAM_USERNAME=$ {SAM_USERNAME-sam-o0}

\?AM_PASSWORD=${SAM_PASSNORD—SGZOSam!}

J

Note: You can start the daemon manually only after the job is run successfully

at least once.

Chapter 8. Deploying Alcatel-Lucent 5620 SAM LogToFile 2.1.0.0 DataStage jobs

55



Data flow in the data subdirectories

Access the data directory from here: /opt/IBM/InformationServer/Server/
Projects/UDM/udm/data.

The data directory contains all the data files. The different subdirectories in the
data directory are as follows:

in When there is a file available message from the SAM server, DataStage job
fetches the XML files and places it in the in directory.

done  After the DataStage job processes these XML files, it moves them into the
done directory. You must clean these XML files to free the space for storage.

cache This directory contains the temporary data that is required by the job for
its processing. This directory contains a set of socket files for inter
communication, map files for sharing the memory among the different
stages, and litedb files are where the data is buffered and stored
temporarily even when the job is shut down to avoid data loss. This data
is then written to the CSV files for UBA to pick up.

out The CSV files are created in the out directory that is based on the
information in the XML files and JMS messages if any.

Important: The files from all these directories are used by the DataStage job for
internal use. Do not delete or alter any of the files from these subdirectories while
the job is running. Otherwise, you might lose some data from the SAM server.

Stopping and starting the IBM InfoSphere Information Server server

engine

This procedure describes how to stop and restart the IBM InfoSphere Information
Server server engine on AIX, Solaris, and Linux operating systems.

About this task

If you edit the dsenv file or modify the uvconfig file, follow this procedure:

Procedure
« AIX® HP-UX Solaris Linux

1. Log in to the engine tier computer as the IBM® InfoSphere DataStage®
administrator (typically, dsadm).

2. Change to the engine directory and set the environment.

cd $DSHOME
. ./dsenv

$DSHOME is the name of the engine directory. The default directory is
/opt/IBM/InformationServer/Server/DSEngine.

3. Stop the engine.
./bin/uv -admin -stop

The command displays a message when the engine stops.
4. Restart the engine.
./bin/uv -admin -start

* Microsoft Windows
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1. In the Windows control panel, open the DataStage Control Panel.
2. Click Stop all services. Wait until the services are stopped.
3. Click Start all services.
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Chapter 9. Setting up the Alcatel-Lucent 5620 SAM servers to
support LogToFile

The SAM server administrator must set up the appropriate SAM servers
environment so that the Alcatel-Lucent SAM 5620 LogToFile Technology Pack
operates correctly.

About this task

Setting up the Alcatel-Lucent 5620 SAM LogToFile servers includes the following
tasks:

Install SAM on the primary and redundant servers

The SAM server administrator should have installed SAM on primary and
redundant servers. The Alcatel-Lucent 5620 SAM LogToFile Technology Pack
accesses the SAM servers to request the inventory and metrics.

Synchronize the clocks

Use the appropriate tool to ensure that the clocks on the SAM server and the
server on which the Tivoli Netcool Performance Manager DataChannel is installed
are identical.

For example, make sure the Coordinated Universal Time (UTC) on the server on
which Tivoli Netcool Performance Manager DataChannel is operating matches the
UTC time on the server on which Alcatel-Lucent 5620 SAM is operating.

Install the Alcatel-Lucent 5620 SAM Client GUI

The SAM server administrator should have installed the Alcatel-Lucent 5620 SAM
Client GUI on some client computer or server.

During the installation, the SAM server administrator configured the IP addresses
of the SAM primary and redundant servers.

Configure an OSS user account

The SAM server administrator uses the Alcatel-Lucent 5620 SAM Client GUI to
configure an OSS (operational support system) user account from the client
computer or server.

This user account consists of a username and password that allows the user to
access the SAM primary and redundant servers. This OSS user account should not
have administrative privileges. The SAM server administrator should record the
username and password for this OSS user account and keep it in a secure place.

The IBM InfoSphere Information Server needs access to this OSS account. The
Alcatel-Lucent SAM 5620 LogToFile Technology Pack supplies the following
parameters in which the previously listed OSS user account information can be
specified:

« SAM.USERNAME
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* SAM.PASSWORD

The Alcatel-Lucent 5620 SAM LogToFile Technology Pack supplies these
parameters for Tivoli Netcool Performance Manager version 1.3.2. These
parameters are in the pack XSD file. You specify values for these parameters as
part of adding a UBA Bulk Collector and associating it with the Alcatel-Lucent
5620 SAM LogToFile Technology Pack. For more information about adding a bulk
collector, see the section on adding a UBA Bulk Collector in the IBM Tivoli Netcool
Performance Manager Installation Guide.

Configure the SAM accounting and polling statistics

60
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Accounting policies are relevant to the Access Interfaces and the metrics that they
report. The type of accounting policy on an Access Interface determines the metrics
that are reported.

When inventory is collected, Tivoli Netcool Performance Manager learns the
accounting policy for each Access Interface. From these accounting policies, the
Alcatel-Lucent 5620 SAM LogToFile Technology Pack can determine the accounting

policy type.

The Alcatel-Lucent 5620 SAM defines and manages accounting policies, which
determine how SAM accounting statistics are collected. The Alcatel-Lucent 5620
SAM LogToFile Technology Pack currently supports two types of SAM accounting
statistic: access-port statistics and network-port statistics. The accounting package
provides a maximum of 13 active accounting policies, one for each type of record
for the eight access-port statistics types and for the five network-port statistics

types.

The SAM server administrator uses the Alcatel-Lucent 5620 SAM Client GUI to
configure SAM accounting statistics on the primary and redundant SAM servers.

The Alcatel-Lucent 5620 SAM LogToFile Technology Pack supports the accounting
policies listed in the Table below, depending on the type of nodes being monitored.

Table 1. Supported accounting policies

Accounting policy Description
CombinedNetworkEgressOctetsLogRecord Manages the collection of octet activity for
egress network queues.
CombinedNetworkIngressOctetsLogRecord Manages the collection of octet activity for
ingress network queues.
CompleteServiceEgressPacketOctets Manages the collection of packet and octet
LogRecord activity for egress service queues.
CompleteServicelngressPacketOctets Manages the collection of packet and octet
LogRecord activity for ingress service queues.
ServiceEgressOctetsLogRecord Manages the collection of octet activity for

egress service queues.

ServiceEgressPacketsLogRecord Manages the collection of packet activity for
egress service queues.

ServicelngressOctetsLogRecord Manages the collection of octet activity for
ingress service queues.

ServiceIngressPacketsLogRecord Manages the collection of packet activity for
ingress service queues.
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Note:

The service.ServiceEgressOctetsLogRecord class and the
service.ServiceEgressPacketsLogRecord class are mutually exclusive. You cannot
collect metrics for both classes at the same time.

Similarly, the service.ServicelngressOctetsLogRecord class and the
service.ServicelngressPacketsLogRecord class are mutually exclusive. You cannot
collect metrics for both classes at the same time.

The SAM server administrator uses the appropriate utility to configure polling
statistics for SAM statistics classes. To configure polling statistics for these SAM
statistics classes, enable the appropriate MIBs on the primary and redundant SAM
servers.

The default Tivoli Netcool Performance Manager collection period for all types of
SAM statistics is set to every fifteen minutes, so the SAM server policies should be
configured to match this default value.

Note: The collection period for any type of SAM statistics must be set to the same
value as the collection period for the corresponding Tivoli Netcool Performance
Manager requests.

Enable the MIBs for the SAM statistics classes

SAM server administrator must enable all of the MIBs listed in the table for the
Alcatel-Lucent 5620 SAM LogToFile Technology Pack.

The first column of the table identifies the SAM statistics class on which to enable
polling statistics; the second column identifies the MIBs to enable for the SAM
statistics classes; and the third column identifies the object types to enable. The
SAM server administrator can enable additional object types, but the
Alcatel-Lucent 5620 SAM LogToFile Technology Pack expects at a minimum the
ones listed in the third column.

Table 2. MIBs to enable for SAM statistics classes

SAM statistics class MIB Object types
equipment.AllocatedMemory | TIMETRA-SYSTEMMIB sgiMemoryPoolAllocat ed
StatsLogRecord

equipment.AvailableMemory | TIMETRA-SYSTEMMIB sgiMemoryAvailable
StatsLogRecord

equipment.Interface IF-MIB ifXEntry
AdditionalStatsLogRecord

equipment.InterfaceStats IF-MIB (located in the file ifEntry

LogRecord named rfc2233- [F-MIB)

equipment.Medialndependent| HC-RMON-MIB medialndependentEntry
StatsLogRecord

equipment.SystemCpuStats | TIMETRA-SYSTEMMIB sgiCpuUsage
LogRecord

equipment.SystemMemory TIMETRA-SYSTEMMIB sgiMemoryUsed
StatsLogRecord

mpls.MplsInterfaceStats TIMETRA-MPLS-MIB vRtrMplsIfStatEntry
LogRecord
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Table 2. MIBs to enable for SAM statistics classes (continued)

SAM statistics class

MIB

Object types

ppp-PppStatsLogRecord and
ppp-PppControlProtocol

TIMETRA-PPP-MIB

tmnxPppEntry

svt.SdpBindingBaseStats
LogRecord

TIMETRA-SERV-MIB

sdpBindBaseStatsEntr y

ethernetequipment.Dot3
StatsLogRecord

EtherLike-MIB

dot3StatsEntry

mpls.SiteStatsLogRecord

TIMETRA-MPLS-MIB

vRtrMplsGeneralStatE ntry

service.PppoeSapStats
LogRecord

TIMETRA-PPPOEMIB

tmnxPppoeSapStatsEnt ry

svq.CustMultiSvcSiteIng
SchedPlcyPortStatsLogRecord

TIMETRA-SERV-MIB

custMultiSvcSiteIngS
chedPlcyPortStatsEnt ry

svq.CustMultiSvcSiteEgr TIMETRA-SERV-MIB custMultiSvcSiteEgrS
SchedPlcyPortStatsLogRecord chedPlcyPortStatsEnt ry
a0sqos.QoSIngressPolicy ALCATEL-IND1- QOS-MIB | alaQoSRuleEntry
StatsLogRecord

equipment.CardHealth ALCATEL-IND1- healthModuleEntry
StatsLogRecord HEALTH-MIB

Set up ping tests

The SAM server enables SAM server administrators to run ping tests in order to
receive information about traffic latency and jitter.

The results from the tests can include SAM statistics such as round-trip time,
one-way trip time, jitter, and so on. These test results can be collected as metrics
against OAM Test object subelements representing the tests.

Note: This section describes one method of creating OAM (ping) tests. This
method uses the Alcatel-Lucent 5620 SAM Client GUI to set up the OAM test to
run periodically using the scheduler on the SAM server. To run the OAM test on
the SAM server, you must set the NE scheduler setting to off. This is only one
method for running OAM tests and is provided for users who have no knowledge
about how to run OAM tests. In other methods for running OAM tests, the NE
scheduler setting can be set to on. In any method employed to run the OAM tests,
the period of the tests must be set to the same value as the period for the metric
requests. The default value is fifteen minutes.

A SAM server administrator can create ping tests in two ways:

Alcatel-Lucent 5620 SAM Client GUI
The Alcatel-Lucent 5620 SAM Client GUI allows a SAM server
administrator to set up a ping test, specifying the period of the test, the
type of test, and so on.

OSS requests
The SAM server administrator may also establish OSS requests that will
create ping tests on the SAM server.

Although these two methods are available, the Alcatel-Lucent SAM 5620 LogToFile
Technology Pack expects that a SAM server administrator will manually set up
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ping tests using the Alcatel-Lucent 5620 SAM Client GUIL For more information
about setting up these ping tests, see the Alcatel-Lucent 5620 Service Aware Manager
Release 7.0 User Guide.

To collect ping-related SAM statistics that are meaningful within Tivoli Netcool
Performance Manager, multiple consecutive data points need to be collected for
any particular OAM Test object subelement. Thus, it is recommended that ping
tests be set up to run on a schedule that lasts for a significant duration (minimum
three hours).

This section summarizes the steps to follow. See the Alcatel-Lucent 5620 Service
Aware Manager Release 7.0 User Guide for details.

* Create a test suite. Make sure the NE Scheduable option is not selected so that
the test schedule runs on the SAM server and not the routers themselves.

* Create one or more ping tests. The Alcatel-Lucent 5620 SAM LogToFile
Technology Pack supports several types of ping tests. Remember not to select
the NE Scheduable option. Make sure the tests run without errors.

* Add the ping tests to the test suite.

* Create a schedule to run the test suite. Set the schedule to run at the same
frequency as the Tivoli Netcool Performance Manager collection requests for
jitter and latency. For example, if Tivoli Netcool Performance Manager collection
requests occur every fifteen minutes, then set the schedule to run the ping test
suite every fifteen minutes.

Note: Ensure that you set the frequency to a value that is consistent with the
other collection periods.

* Apply the schedule to the test suite and run the tests contained in the suite.
Each time a test completes, Tivoli Netcool Performance Manager collects a set of
metrics.

SAM server administrators can run several types of ping tests to measure traffic
characteristics at different levels of the network stack. Each ping test is represented
by its own SAM class and associated ping result class. For more information about
these classes, see the Alcatel-Lucent 5620 SAM XML Reference - Release 7.0
documentation.
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Chapter 10. Modifying the collection strategy

This chapter describes how to modify the amount of data that is managed by the
Alcatel-Lucent 5620 SAM LogToFile Technology Pack. You can make this
modification by changing the types of data that are collected, or by changing the
collection period for the SAM statistics, or both.

Specifying what inventory and metrics to collect

The types of inventory and metrics that must be collected from SAM server is
specified in the configuration files. These configuration files are found on the
DataStage server. The configuration files specify which inventory class and metrics
classes must be requested from the SAM server. The SAM server then creates the
necessary files that are received by DataStage.

About this task

There are 3 different configuration items:
Filter Drops the records

Partition
Enables multiple UBAs

Window
Handles different periods. for example 5, 15, and so on.

Filter:
The name of the filter file is filter_lookup.csv, and has the configuration level as
User. No match for this file is not available.

Fields Steps to get the information.

Class name Name of the SAM Class. For metric classes,
use <class name>LogRecord names.

Expression Set it as '1' (boolean true) if no filter is
needed.

The Expression field accepts full blown perl expressions with special variables
enclosed with '{}' to refer to attributes within the class. There is a special
'{DEFAULTY} to refer to the partition key attribute of the class. For example,
equipment.PhysicalPort, {DEFAULT} eq "1.1.1.1"

It means that the DataStage filter allows only the equipment.PhysicalPort class
objects that has "1.1.1.1" value for its siteld.

equipment.PhysicalPort,{cardSlotId} != 2
It means that the DataStage filter allows only the equipment.PhysicalPort class
objects other than the card slot id of 2.

equipment.PhysicalPort, {DEFAULT} eq "1.1.1.1" && {cardSlotId} != 2 logical
operator is supported.

equipment.PhysicalPort, {DEFAULT} =~ /*1.1/

Regular expression is supported. It allows site key that starts with "1.1"
equipment.PhysicalPort,0 It is the simple way to filter out all records of class
equipment.PhysicalPort. For example, abc@IBM-R8LPF23:~/works/datastage/
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eclipse/workspace37/udm/cfg$ grep equipment.PhysicalPort

relation_lookup.csv
Performance,RouterObject,5620 SAM PhysicalPort,equipment.PhysicalPort,siteld,1
and abc@IBM-R8LPF23:"~/works/datastage/eclipse/workspace37/udm/cfg$ grep
equipment.PhysicalPort csv_lookup.csv

* equipment.PhysicalPort,accountingPolicyld

* equipment.PhysicalPort,actualSpeed

* equipment.PhysicalPort,administrativeState

* equipment.PhysicalPort,cardSlotld

* equipment.PhysicalPort,collectStats

¢ equipment.PhysicalPort,daughterCardSlotld

* equipment.PhysicalPort,description

* equipment.PhysicalPort,displayedName

* equipment.PhysicalPort,encapType

¢ equipment.PhysicalPort,equipmentState

* equipment.PhysicalPort,isLinkUp

* equipment.PhysicalPort,lagMembershipld

* equipment.PhysicalPort,macAddress

* equipment.PhysicalPort,mode

* equipment.PhysicalPort,networkQueueObjectPointer
* equipment.PhysicalPort,networkQueuePolicyCapable
* equipment.PhysicalPort,networkQueuePolicyName
* equipment.PhysicalPort,objectFullName

* equipment.PhysicalPort,operationalState

* equipment.PhysicalPort,portld

¢ equipment.PhysicalPort,portName

* equipment.PhysicalPort,shelfld

* equipment.PhysicalPort,siteld

* equipment.PhysicalPort,siteName

* equipment.PhysicalPort,snmpPortld

* equipment.PhysicalPort,speed

Configuring multiple UBA collectors instances

Partitioning
The UBA partitioning involves 2 configuration files:

1. collector _Tookup.csv
2. collector_mapping.csv

collector_lookup.csv: The name of the filter file is collector_Tlookup.csv, and has
the configuration level as User. No match for this file is not available.

Fields Steps to get the information.

Collector id Id for the collector based on the UBA
configuration

Class category Performance or Accounting
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Note: You must update this configuration.

collector_mapping.csv: The name of the filter file is collector_mapping.csv, and
has the configuration level as User. No match for this file is not available.

Fields

Steps to get the information.

Class Family

Possible family classes are:
5620_SAM_AingrAengrQueue
5620_SAM_Aosqos_Policy
5620_SAM_CardSlot
5620_SAM_CfmEthTest
5620_SAM_CfmOneWayDelay
5620_SAM_CfmSingleEndedLoss
5620_SAM_Channel
5620_SAM_Hw_Environment
5620_SAM_LAGInterface
5620_SAM_MPLSInterface
5620_SAM_MPLS_Site
5620_SAM_MSS
5620_SAM_NQueue
5620_SAM_OAM_Test
5620_SAM_PhysicalPort
5620_SAM_PPP_Interface
5620_SAM_PPP_Protocol
5620_SAM_SdpBinding
5620_SAM_ServiceAccessInterface
5620_SAM_Shelf
5620_SAM_Virtual_Router

Key value

The value for key. The key is from the
relation lookup configuration. Most of these
keys are based on the IP address. The
objectFullName can also be used as a key.

Collector id

Id for collector based on the desired UBA
destination.

Note: This configuration is intended for new elements from SAM that the user
wants to overwrite the default hash key rule. For example, a user can force the
element to go to a specific collector or UBA for better load balance. However, this

configuration does not overwrite mapping
Therefore, following is the partition rule:

that the Job gathers from Proviso.

Mapping from Priviso DB » collector_mapping.csv » Job key hash.
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Changing the collection period for SAM statistics

This section provides general guidelines on how to change the collection period for
SAM statistics:

* [‘General guidelines on changing the collection period for SAM statistics”|

General guidelines on changing the collection period for SAM
statistics

The default collection period for all SAM statistics is 15 minutes. If you change any
collection period, ensure that you follow these guidelines:

1. You must set the APPFILE_PERIOD parameter (on each UBA component) and
the WINDOW_PERIOD parameter (on the IBM InfoSphere Information server) to
equivalent values.

For example, if you set the APP.FILE_PERIOD parameter to 600 (that is, 600
seconds, or 10 minutes), then you must set the WINDOW_PERIOD parameter to
0,10,20,30 * * * *

Note: The APPFILE_PERIOD parameter is specified in seconds, and the
SAM.WINDOW_PERIOD parameter is specified as a series of values expressed in
minutes.

2. The collection period for any type of SAM statistics must be set to the same
value as the collection period for the corresponding Tivoli Netcool Performance
Manager requests.

On DataStage:

You can configure the SAM classes 5 Minutes period. This configuration are done
at the SAM Server. However, you must specify this period information in the Job
parameter to enable Job, which produces the CSV file at the correct period interval.
WINDOW_PERIOD is measured in seconds. The default values are 900 and 300 for 5
Minutes.

WAVE_PERIOD is an internal window sliding period. This value must be non-zero
integer, a denominator value for WINDOW_PERIOD. The default values are 900 and 300
for 5 Minutes.

WAIT_DURATION is the amount of time to wait for complete records for a period
before writing to the CSV file. This value must be divisible by WAVE_PERIOD. The
default values are 900 and 300 for 5 Minutes.

The Alcatel-Lucent 5620 SAM LogToFile Technology Pack supplies these
parameters based on the following Tivoli Netcool Performance Manager platforms:

Tivoli Netcool Performance Manager 1.3.2 - These parameters are supplied in the
pack XSD file. You specified values for these parameters as part of adding a UBA
Bulk Collector and associating it with the Alcatel-Lucent SAM 5620 LogToFile
Technology Pack. See the section on adding a UBA Bulk Collector in the IBM Tivoli
Netcool Performance Manager Installation Guide for more information.
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List of classes that must be enabled or disabled

This topic contains the list of classes that must enabled or disabled in the
DataStage requestxml_Tookup.csv file. The requestxml_Tlookup.csv file is in
/opt/IBM/InformationServer/Server/Projects/UDM/udm/cfg directory.

Classes that must be enabled:

* aengr.ForwardingClass

* aengr.Policy

* aengr.Queue

¢ aingr.ForwardingClass

* aingr.Policy

* aingr.Queue

* aosqos.Policy

* a0sqos.QoSIngressPolicyStatsLogRecord

* epipe.Epipe

* equipment.AllocatedMemoryStatsLogRecord
* equipment.AvailableMemoryStatsLogRecord
* equipment.CardHealthStatsLogRecord

* equipment.CardSlot

* equipment.HwEnvironment (metrics)

* equipment.HwEnvironment

* equipment.InterfaceAdditionalStatsLogRecord
* equipment.InterfaceStatsLogRecord

* equipment.MedialndependentStatsLogRecord
* equipment.PhysicalPort

* equipment.Shelf

* equipment.SystemCpuStatsLogRecord

* equipment.SystemMemoryStatsLogRecord
¢ ethernetequipment.Dot3StatsLogRecord

¢ ethernetoam.CfmEthTest

* ethernetoam.CfmLoopback

¢ ethernetoam.CfmOneWayDelayTest

* ethernetoam.CfmTwoWayDelayTest

* ethernetoam.Mep

* icmp.IcmpPing

* ies.L3AccessInterface

* ies.ServiceAccessPoint

* ipipe.L2AccessInterface

* lag.Interface

* mpls.Interface

* mpls.LspPing

* mpls.MplsInterfaceStatsLogRecord

e mpls.Site

* mpls.SiteStatsLogRecord

* nqueue.Entry
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* nqueue.ForwardingClass

* nqueue.Policy

* ppp-Interface

* ppp-PppControlProtocol (metrics)

* ppp-PppControlProtocol

¢ rtr.RouteStatsLogRecord

* rtr.VirtualRouter

* sasqos.AccessIngress

* sasqos.Meter

* sasqos.PortAccessEgress

* sasqos.PortAccessEgressQueue

* service.CombinedNetworkEgressOctetsLogRecord

* service.CombinedNetworkIngressOctetsLogRecord

* service.CompleteServiceEgressPacketOctetsLogRecord
* service.CompleteServicelngressPacketOctetsLogRecord
* service.PppoeSapStatsLogRecord

* sonetequipment.Sts12Channel

* sonetequipment.Sts1Channel

* sonetequipment.Sts48Channel

* svq.AggregationScheduler

* svt.MeshSdpBinding

* svt.MirrorSdpBinding

* svt.SdpBindingBaseStatsLogRecord

* svt.SpokeSdpBinding

e svt.TunnelPing

* svt.VcevPing

* vlLL2AccessInterface

* vpls.L2AccessInterface

* vpls.Vpls

* vprn.ServiceAccessPoint

¢ ethernetoam.CfmLoopbackResult

* ethernetoam.CfmTwoWayDelayTestResult

¢ ethernetoam.CfmSingleEndedLossTest

e icmp.IempPingResult

¢ svt.TunnelPingResult

* svt.VcevPingResult

* service.SitePing

* svq.CustMultiSvcSiteEgrSchedPlcyPortStatsLogRecord
* svq.CustMultiSvcSiteIngSchedPlcyPortStatsLogRecord

Classes that must be disabled:

* equipment.DigitalDiagnosticMonitoring

¢ ethernetoam.CfmEthTestResult

* ethernetoam.CfmOneWayDelayTestResult

* ethernetoam.CfmSingleEndedLossTestResult
* mirror.L2AccessInterface
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ppp-PppStats

sasqos.AccessIngressForwardingClass

sasqos.PortAccessEgressForwardingClass

service.NetworkEgressPackets
service.NetworkIngressPackets
service.ServiceEgressOctets
service.ServiceEgressPackets
service.ServicelngressOctets
service.ServicelngressPackets
service.SitePingResult
sonetequipment.Sts192Channel
sonetequipment.Sts3Channel
sonetequipment.TributaryChannel
sonetequipment.TributaryGroup
sonetequipment.Tu3Channel
sonetequipment.Tug3Group
tdmequipment.DSOChannelGroup
tdmequipment.DS1E1Channel
tdmequipment. DS3E3Channel

vprn.L3AccessInterface
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Chapter 11. Troubleshooting Alcatel-Lucent 5620 SAM
LogToFile Technology Pack

Troubleshooting tips for issues related to Alcatel-Lucent 5620 SAM LogToFile
Technology Pack and its related components.

Specifying parameter values

Several of the tips to tell you to make sure that the correct values were specified
for parameters in the deployed topology.

You specify the values for these parameters in one of the following ways,
depending on the Tivoli Netcool Performance Manager platform:

Tivoli Netcool Performance Manager 1.3.2

These parameters are supplied in the pack XSD file. You used the Topology Editor
to specify a value for these parameters as part of adding a UBA Bulk Collector and
associating it with the Alcatel-Lucent 5620 SAM Technology Pack. For more
information, see the section on adding a UBA Bulk Collector in the IBM Tivoli
Netcool Performance Manager Installation Guide.

Inventory issues

If you do not see the expected inventory in your Tivoli Netcool Performance
Manager instance, use the information in this section. Complete the steps in each
subsection, to verify that you have configured your instance correctly.

Metric data collection issues

If you do not see the expected metrics in your Tivoli Netcool Performance
Manager instance, use this information. Complete the steps in each subsection, to
verify that you have configured your instance correctly.

The following sections provide an overview of metric data, and describe
troubleshooting tips for issues related to the metric data collection:

Overview of metric data
The SAM server supports the following types of metric data:

Polled

Polled metric data is collected by the SAM server from the routers using
SNMP. To collect this data, MIBs must be enabled on the SAM server, and
polling periods must be set. For more information about the MIBs that are
needed, see [“Enable the MIBs for the SAM statistics classes” on page 61.|

Exception to the Rule: The exception is the HwEnvironmentTemperature files.
These files are in effect inventory files in which the temperature properties
are read in as metrics. For a variety of reasons related to this data not
being real metrics, the temperature data is only available for a subelement
under the following conditions:

e The CPU utilization metric for that subelement is available.
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¢ The data being processed is “current”: the UBA has caught up to the
wall-clock time as much as is possible, and no backlog of data is being
processed.

Accounting
Accounting metric data is collected by the routers into files. These files are
retrieved by the SAM server, and read into its database. To get this data,
the accounting and file policies must be configured on the SAM server and
distributed to the routers. Accounting data is the data collected for
services. For more information about accounting data, see
[SAM accounting and polling statistics” on page 60,

Availability data
The availability data is collected from the SAM Server and is converted
into CSV datafile records. This CSV datafile records are then picked by the
UBAs.

The Alcatel-Lucent 5620 SAM LogToFile Technology Pack uses the following syntax
for metric-data file names:

provisoPerformance_2013.02.25-01.00.00_100.csv

Here is an example file name for a metric-data file:
provisoAccounting_2013.02.25-01.05.00_101.csv

SAM metrics do not display in the Alcatel-Lucent 5620 SAM
Client GUI

The SAM server administrator uses the Alcatel-Lucent 5620 SAM Client GUI to
display metrics for the different objects (for example, services and network
elements) located in a SAM network environment.

If SAM metrics do not display in the Alcatel-Lucent 5620 SAM Client GUI,
complete the following troubleshooting steps:

1. Enable the appropriate MIBs for the polled data.
2. Enable an accounting policy for the service data.

SAM metric files are empty or do not exist in the SAM server
Typically, SAM metric files are transferred to a directory, such as
/opt/5620sam/nms/server/xml_output, on the SAM server.

If the SAM metric files are empty (that is, the XML file has left and right angle
brackets with no data, and is 60 bytes or less), complete the following
troubleshooting steps:

1. Determine whether the absence of data is because there are no inventory
elements and subelements from which to receive metrics.

2. Ensure that you enabled the appropriate MIBs for polled data.
3. Ensure that you enabled an accounting policy for service data.

4. Ensure that you have set your filter parameters correctly. For more information
about filter parameters, see [‘Specifying what inventory and metrics to collect”]

If SAM metric files do not exist in the SAM server, complete the following
troubleshooting steps:

1. Make sure that an OSS user account is configured. See [“Configure an OSS user|
[account” on page 59 for more information.
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2. Make sure that the correct values were specified for the SAM.USERNAME and
SAM. PASSWORD parameters, as described in [‘Specifying parameter values” on|
based on the Tivoli Netcool Performance Manager platform:

Platform

Parameter

Tivoli Netcool Performance Manager 1.3.2

ALCATEL_5620_SAM. SAM.USERNAME
ALCATEL_5620_SAM. SAM.PASSWORD

3. Make sure that the correct value was specified for the SAM.SAM VERSION

parameter, as described in [“Specifying parameter values” on page 73 based on

the Tivoli Netcool Performance Manager platform:

Platform

Parameter

Tivoli Netcool Performance Manager 1.3.2

ALCATEL_5620_SAM.SAM.SAM_VERSION

The SAM.SAM_VERSION parameter refers to the JMS protocol version, not the

SAM server version.

4. Make sure that the correct values were specified for the SAM.SOAP_URI and
SAM.SOAP_URI_2 parameters, as described in [“Specifying parameter values” on
based on the Tivoli Netcool Performance Manager platform:

Platform

Parameter

Tivoli Netcool Performance Manager 1.3.2

ALCATEL_5620_SAM.SAM.SOAP_URI
ALCATEL_5620_SAM.SAM.SOAP_URI_2

5. Check the UNIX file permissions. Ensure that the permissions on the
xml_output directory are set to allow read, write, and execute by the SAM FTP

user.

6. Ensure that you have enough disk space. For more information, see M

[collection fails due to lack of disk space” on page 76.|

BOF files do not exist in the FTE output directory
Typically, the DataChannel File Transfer Engine (FTE) application transfers BOFs
(Binary Object Files) to the DataChannel FTE application output directory.

If the BOF files are not transferred to the FTE application output directory,
complete the following troubleshooting steps:

1. Make sure that an FTP user account is configured on the primary and

redundant SAM servers.

2. Make sure that the user exists on the SAM server and that the correct FTP
username and password values were specified for the SAM. EXPORT URI and
SAM.EXPORT URI_2 parameters, as described in [“Specifying parameter values” on|
based on the Tivoli Netcool Performance Manager platform:

Platform

Parameter

Tivoli Netcool Performance Manager 1.3.2

ALCATEL_5620_SAM.SAM.EXPORT_URI
ALCATEL_5620_SAM.SAM.EXPORT URI 2

3. Check the UNIX permissions.

4. Ensure that you have enough disk space. For more information, see

collection fails due to lack of disk space” on page 7
p pag
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BOF files do not exist in the CME output directory

Typically, the DataChannel File Transfer Engine (FTE) application transfers BOFs
(Binary Object Files) to the DataChannel Complex Metric Engine (CME) application
output directory.

If the BOF files are not transferred to the CME application output directory,
complete the following troubleshooting steps:

1. Make sure that you imported the Alcatel-Lucent 5620 SAM LogToFile
Technology Pack predefined collection requests.

2. Check the UNIX permissions.

3. Ensure that you have enough disk space. For more information, see
[collection fails due to lack of disk space.’]

Metrics collection fails due to lack of disk space

If the metric-collection operation fails on the SAM server, make sure that you have
enough disk space on the computer or server on which Tivoli Netcool Performance
Manager is installed.

The amount of space required depends on the following;:
* Size of the SAM network
* Values set for the following retention parameters in the dc.cfg file:

Platform Parameter

Tivoli Netcool Performance Manager 1.3.2 FC_RETENTION_HOURS

It is possible, in a SAM networking environment, that several gigabytes worth of
data files could be collected and transferred to the UBA application done
directory each day. These data files accumulate according to the values specified
for the retention parameters. Therefore, it is possible to use the maximum disk
space before the retention period expires and the DataChannel deletes the data
files from the done directory.

You must monitor the size of the data files transferred to the done directory
during metric collection, and determine whether adjustments must be made to
the retention parameters.

General Alcatel-Lucent 5620 SAM LogToFile 2.1.0.0 Technology Pack

issues

These are the general issues for Alcatel-Lucent 5620 SAM LogToFile 2.1.0.0
Technology Pack.

The subelement time changes on several unexpected
occasions

In the Resource Editor, the subelement date must change when:

* A subelement is added, updated, or deleted

* JMS event is triggered

However, in the Alcatel-Lucent 5620 SAM LogToFile Technology Pack, the
subelement date also changes when:

* A full dump file is processed by the UBA even if a subelement is not inserted,
updated, or deleted

* Performance or Accounting CSV file is created by DataStage
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 Alcatel-Lucent 5620 SAM is upgraded to Alcatel-Lucent 5620 SAM LogToFile

Synchronize the time on the IBM InfoSphere Information
server and the SAM server

Symptoms
Typically, there is a time difference on the IBM InfoSphere Information server and
the SAM server. This may result in incorrect timestamps on the generated reports.

Causes
Time at the IBM InfoSphere Information server and the SAM server is not
synchronized.

Resolving the problem

To resolve this issue, set the SAM server time to be same as the IBM InfoSphere
Information server even if both servers are at different timezone. To verify whether
both servers are synchronized, run the date +%s command, and make sure that the
value that is returned for both servers is same.

Data is not displayed properly in the Volume and Utilization
report
Symptoms
You browse to the following path on the Tivoli Integrated Portal to run the Volume
and Utilization report: NOC Reporting > Alcatel-Lucent 5620 SAM > SAM
Router Health > Link Aggregation Groups (LAG Interfaces) > Volume &
Utilization Group Summary. The report is displayed on the right. In the Inbound
Utilization and Outbound Utilization fields, --, 0, and No Data Available, are
displayed respectively in the following tables:
* Group Summary
* Resource Summary

¢ Detail Chart

Partitioning must be done at the element level

Symptoms

DataStage collector mapping configuration provides fine level of partitioning at the
subelement level. However, some subelements must be configured to the same
collector. Because this rule is not verified by the DataStage job, mistakes might be
introduced in the relation lookup configuration file.

Resolving the problem
To avoid this problem, you must create the partition at the element level only. You
must configure all family names for an element to a single set of collectors.

The CSV filename changes when you map another class that
does not correspond to its collector
Symptoms
On DataStage, the CSV file in the out directory is not correctly named. For
example, the provisoAccounting_2013.02.18-08.05.00_101.csv file is incorrectly
named as provisoPerformance_2013.02.18-08.05.00_101.csv.

Causes

This problem occurs when you map one more class that does not correspond to its
collector in the collector_mapping.csv file. For example, in the
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collector_lookup.csv file, you set the 101 collector as Accounting. However, in the
collector_mapping.csv file, instead of the Accounting class, you map one or more
Performance classes to the 101 collector. As a result, the Accounting 101 collector
gets mixed with the Performance classes, and you find the

provisoPerformance 2013.02.18-08.05.00_101.csv file instead of
provisoAccounting_2013.02.18-08.05.00_101.csv file in the out directory.

Device and Service Availability feature causes missing
intervals in the report
Symptoms
When the Device and Service Availability feature is enabled, you might notice
intermittent missing intervals in the report.

Resolving the problem
To resolve this issue, ensure that the Device and Service Availability is turned off.
To do this, follow these steps:

1. Open the Topology Editor.

2. Open the existing topology that is deployed for Alcatel-Lucent 5620 SAM
LogToFile 2.1.0.0 Technology Pack.

3. Click the Collectors that are deployed for the Alcatel-Lucent 5620 SAM
LogToFile 2.1.0.0 Technology Pack.

4. Go to the Advanced Properties pane.

5. Change ALCATEL_5620_SAM_LOG2FILE.AVAIL_NAME_SPACE_ACTIVE property to
False.

When you turn off the Device and Service Availability feature, there is an impact
on the following metrics and reports:

Note: These metrics and report sets do not return any data.

NOC Reporting™Alcatel-Lucent 5620 SAM™SAM Router Health™Interface
Availability

* Availability (percent)

* Unavailable (percent)

* Availability Unknown (percent)
* State Transitions

NOC Reporting™Alcatel-Lucent 5620 SAM™SAM Services™Access Interface
(SAPs)™SAP Interface Availability

* Availability (percent)

* Unavailable (percent)

* Availability Unknown (percent)
* State Transitions

The OAM data exists at the SAM server but is not transferred
to DataStage
Symptoms
The OAM data exists at the SAM server in the xm1_ouput directory. However, this
data is not transferred to DataStage at DS/done.

Diagnosing the problem
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To identify the cause of the problem, follow these steps:

1.

Run this command to verify if the registerSasLogToFile requests are sent to
the SAM server:

$ grep -q "“registerSasLogToFile" ./data/responsexmls.csv && echo "yes, there is a response for the request!"
Run this command to identify if an exception has occurred:
$ grep "“registerSaslLogToFile" ./data/responsexmls.csv | grep -i "exception"

# None - all ok

Check if the TogFileAvailable message is received from the SAM JMS for these
saslLogToFile:

$ grep "/oam/" ./logs/sam-jms-daemon.log

# None - No message is received.

Note: /oam/ is the parent directory for these classes.
Check if there is a problem with the register sasLogToFile:

$ grep "“registerSaslLogToFile" ./data/responsexmls.csv | perl -e

'while (<>){m/<fullClassName >(.*)<\/fullClassName>/; print $1."\n"}' | sort | unig
ethernetoam.CfmLoopbackResult

ethernetoam.CfmTwolWayDelayTestResult

icmp. IcmpPingResult

mpls.LspPingResult

svt.TunnelPingResult

svt.VccvPingResult

$ grep "“registerSasLogToFile" ./data/responsexmls.csv | wc -1

222

# Unexpected logs of registerSasLogToFile - you must expect up to 6 lines,
which means 6 classes.You notice 222 Tines that is not correct.

Note: You can view logs after you run the command as explained in
Check the number of times SasLogToFile is unregistered and registered:

$ grep registerSasLog ./data/responsexmls.csv | cut -d, -fl

Check times when the SasLogToFile is unregistered and registered:

$ grep deregisterSaslLogToFile ./data/responsexmls.csv | perl -e
'while (<>){m/responseTime>(.*)<\/responseTime>/; print §1."\n"}'

You can see the following output:

/;eb 22, 2013 11:30:56 AM Feb 22, 2013 11:32:33 AM Feb 22, 2013 11:37:33 AM
Feb 22, 2013 11:42:33 AM Feb 22, 2013 11:47:33 AM Feb 22, 2013 11:52:33 AM
Feb 22, 2013 11:57:33 AM Feb 22, 2013 12:02:33 PM Feb 22, 2013 12:07:33 PM
Feb 22, 2013 12:12:33 PM Feb 22, 2013 12:17:33 PM Feb 22, 2013 12:22:33 PM
Feb 22, 2013 12:27:33 PM Feb 22, 2013 12:32:33 PM Feb 22, 2013 12:37:33 PM
Feb 22, 2013 12:42:33 PM Feb 22, 2013 12:47:33 PM Feb 22, 2013 12:52:33 PM
Feb 22, 2013 12:57:33 PM Feb 22, 2013 1:02:33 PM Feb 22, 2013 1:07:33 PM
Feb 22, 2013 1:12:33 PM Feb 22, 2013 1:17:33 PM Feb 22, 2013 1:22:33 PM
Feb 22, 2013 1:27:33 PM Feb 22, 2013 1:32:33 PM Feb 22, 2013 1:37:33 PM
Feb 22, 2013 1:42:33 PM Feb 22, 2013 1:47:33 PM Feb 22, 2013 1:52:33 PM

\feb 22, 2013 1:57:33 PM Feb 22, 2013 2:02:33 PM Feb 22, 2013 2:07:33 PM )

Note: The register cycle happens every 5 minutes, which is same as the
window period.

Verify whether the keepalive event is sent by SAM:

$ grep KeepAliveEvent ./Togs/sam-jms-daemon.log | grep -v "Connected to JMS"
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# no keepalive events. This indicates that SAM does not send the keepAlive
message but the Monitor stage, which expects keepalive message per period is
falsely indicated that the daemon is not functioning properly, and restarts the
daemon in cycle.

Resolving the problem
To turn off the keepAlive check, follow the steps in [“How to turn off the keepAlive|

message flag”

General IBM InfoSphere Information Server software related issues

These are the general issues for IBM InfoSphere Information Server software other
software that is required for Alcatel-Lucent 5620 SAM LogToFile 2.1.0.0 Technology
Pack.

Troubleshooting IBM InfoSphere Information Server
installations

You can resolve all installation problems, with this information.

For all troubleshooting problems with installation, see |http: // |
publib.boulder.ibm.com/infocenter/iisinfsv /v8r7/ topic/|
com.ibm.swg.im.iis.productization.iisinfsv.install.doc/topics/|
wsisinst_ts_is_container.html| You can find more troubleshooting information in the
information centers and customer support technical notes for various product
modules and components.

DataStage job stops running because of insufficient buffer
size

Symptoms

When the buffer size is insufficient, you might encounter a unrecoverable error and

the job stops running. You receive the following error:

The record is too big to fit in a block; the Tength requested is: 131952, the max block Tength is: 131072

Causes
You receive this error if the record length exceeds the block size.

Resolving the problem

To resolve this issue, increase the APT_DEFAULT_TRANSFER_BLOCK_SIZE accommodate
the size. For more information about how to increase the size of this parameter, see
lhttp:/ /www-01.ibm.com/support/docview.wss?uid=swg21386618|

How to turn off the keepAlive message flag

By default, the keepAlive message flag is turned on. You can manually turn off this
flag.

Symptoms

When you do not see the keepAlive messages that are coming in, the daemon
process might get restarted. To avoid that, you can turn off the keepAlive message
flag.

Resolving the problem

To turn off the keepAlive message flag, follow these steps:

80 IBM Tivoli Netcool Performance Manager: Alcatel-Lucent 5620 SAM LogToFile 2.1.0.0 Technology Pack Installation and User
Guide


http://publib.boulder.ibm.com/infocenter/iisinfsv/v8r7/topic/com.ibm.swg.im.iis.productization.iisinfsv.install.doc/topics/wsisinst_ts_is_container.html
http://publib.boulder.ibm.com/infocenter/iisinfsv/v8r7/topic/com.ibm.swg.im.iis.productization.iisinfsv.install.doc/topics/wsisinst_ts_is_container.html
http://publib.boulder.ibm.com/infocenter/iisinfsv/v8r7/topic/com.ibm.swg.im.iis.productization.iisinfsv.install.doc/topics/wsisinst_ts_is_container.html
http://publib.boulder.ibm.com/infocenter/iisinfsv/v8r7/topic/com.ibm.swg.im.iis.productization.iisinfsv.install.doc/topics/wsisinst_ts_is_container.html
http://www-01.ibm.com/support/docview.wss?uid=swg21386618

1. In the IBM InfoSphere DataStage and QualityStage Designer. Double-click the
Job. The job opens in canvas.

Stop the Job.

Right-click the Monitor_Stage and select Properties.

In the Monitor_Stage -JTransformerPX stage window, click the Properties tab.
Update the parameter sam_keepalive_max_missed from 1 to 0.

Click OK.

[Compild and |restart] the Job.

N o oo s~ 0N

Verifying that the ports are enabled for all the components
required for Alcatel-Lucent 5620 SAM LogToFile 2.1.0.0
Technology Pack

Enabling the ports for all the components that are required for Alcatel-Lucent 5620
SAM LogToFile 2.1.0.0 Technology Pack. This is applicable for Apache Active MQ
also.

Symptoms

If you cannot access the IBM InfoSphere Information Server server or client
components, verify that the component ports are enabled. To check the status of
the ports, use the following command:

iptables -L

Resolving the problem
For more information about enabling the ports, see [“Enabling the firewall on the]

[BM InfoSphere Information Server and WebSphere Application Server” on page|
52,
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Notices

This information was developed for products and services offered in the U.S.A.
IBM may not offer the products, services, or features discussed in this document in
other countries. Consult your local IBM representative for information on the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may
be used instead. However, it is the user's responsibility to evaluate and verify the
operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not give you
any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation

North Castle Drive

Armonk, NY 10504-1785 U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM
Intellectual Property Department in your country or send inquiries, in writing, to:

Intellectual Property Licensing

Legal and Intellectual Property Law
IBM Japan, Ltd.

19-21, Nihonbashi-Hakozakicho, Chuo-ku
Tokyo 103-8510, Japan

The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local law:

INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS
PUBLICATION "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE.

Some states do not allow disclaimer of express or implied warranties in certain
transactions, therefore, this statement might not apply to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. IBM may make improvements
and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for
convenience only and do not in any manner serve as an endorsement of those Web
sites. The materials at those Web sites are not part of the materials for this IBM
product and use of those Web sites is at your own risk.
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IBM may use or distribute any of the information you supply in any way it
believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact:

IBM Corporation

274A /101

11400 Burnet Road
Austin, TX 78758 U.S.A.

Such information may be available, subject to appropriate terms and conditions,
including in some cases payment of a fee.

The licensed program described in this document and all licensed material
available for it are provided by IBM under terms of the IBM Customer Agreement,
IBM International Program License Agreement or any equivalent agreement
between us.

Any performance data contained herein was determined in a controlled
environment. Therefore, the results obtained in other operating environments may
vary significantly. Some measurements may have been made on development-level
systems and there is no guarantee that these measurements will be the same on
generally available systems. Furthermore, some measurement may have been
estimated through extrapolation. Actual results may vary. Users of this document
should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of
those products, their published announcements or other publicly available sources.
IBM has not tested those products and cannot confirm the accuracy of
performance, compatibility or any other claims related to non-IBM products.
Questions on the capabilities of non-IBM products should be addressed to the
suppliers of those products.

This information contains examples of data and reports used in daily business
operations. To illustrate them as completely as possible, the examples include the
names of individuals, companies, brands, and products. All of these names are
fictitious and any similarity to the names and addresses used by an actual business
enterprise is entirely coincidental.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which
illustrate programming techniques on various operating platforms. You may copy,
modify, and distribute these sample programs in any form without payment to
IBM, for the purposes of developing, using, marketing or distributing application
programs conforming to the application programming interface for the operating
platform for which the sample programs are written. These examples have not
been thoroughly tested under all conditions. IBM, therefore, cannot guarantee or
imply reliability, serviceability, or function of these programs. You may copy,
modify, and distribute these sample programs in any form without payment to
IBM for the purposes of developing, using, marketing, or distributing application
programs conforming to IBM'’s application programming interfaces.
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If you are viewing this information in softcopy form, the photographs and color
illustrations might not be displayed.

Trademarks

IBM, the IBM logo, and ibm.com are trademarks or registered trademarks of
International Business Machines Corp., registered in many jurisdictions worldwide.
Other product and service names might be trademarks of IBM or other companies.
A current list of IBM trademarks is available on the Web at “Copyright and
trademark information” at |attp:/ /www.ibm.com/legal /copytrade.shtml]

Adobe, Acrobat, PostScript and all Adobe-based trademarks are either registered
trademarks or trademarks of Adobe Systems Incorporated in the United States,
other countries, or both.

Cell Broadband Engine and Cell/B.E. are trademarks of Sony Computer
Entertainment, Inc., in the United States, other countries, or both and is used under
license therefrom.

Intel, Intel logo, Intel Inside, Intel Inside logo, Intel Centrino, Intel Centrino logo,
Celeron, Intel Xeon, Intel SpeedStep, Itanium, and Pentium are trademarks or
registered trademarks of Intel Corporation or its subsidiaries in the United States
and other countries.

IT Infrastructure Library is a registered trademark of the Central Computer and
Telecommunications Agency which is now part of the Office of Government
Commerce.

ITIL is a registered trademark, and a registered community trademark of the Office
of Government Commerce, and is registered in the U.S. Patent and Trademark
Office.

@ Java and all Java-based trademarks and logos are trademarks or registered
Lq__(_ 3 trademarks of Sun Microsystems, Inc. in the United States, other countries,
—— or both.

Java

COMPATIBLE

Linux is a trademark of Linus Torvalds in the United States, other countries, or
both.

Microsoft, Windows, Windows NT, and the Windows logo are trademarks of
Microsoft Corporation in the United States, other countries, or both.

UNIX is a registered trademark of The Open Group in the United States and other
countries.

Notices 85


http://www.ibm.com/legal/copytrade.shtml

86 IBM Tivoli Netcool Performance Manager: Alcatel-Lucent 5620 SAM LogToFile 2.1.0.0 Technology Pack Installation and User
Guide






Printed in USA



	Contents
	Tivoli Netcool Performance Manager - Alcatel-Lucent 5620 SAM LogToFile 2.1.0.0 Technology Pack Installation and User Guide
	Intended audience
	Tivoli Netcool Performance Manager - Wireline Component

	Chapter 1. Alcatel-Lucent 5620 SAM LogToFile 2.1.0.0 Technology Pack overview
	UBA structure
	Dynamic models
	Data collection model
	Alcatel-Lucent 5620 SAM LogToFile 2.1.0.0 Technology Pack job design


	Chapter 2. Devices and services
	Alcatel-Lucent 5620 SAM server compatibility
	Supported devices
	Alcatel-Lucent 5620 SAM LogToFile services
	Bulk input file formats
	Bulk adapter design files

	Chapter 3. Installing the Alcatel-Lucent 5620 SAM LogToFile 2.1.0.0 Technology Pack
	Prerequisite software
	Prerequisite software for Alcatel-Lucent 5620 SAM LogToFile 2.1.0.0 Technology Pack installation
	Additional information

	Preinstallation setup tasks
	Preparing the Alcatel-Lucent 5620 SAM LogToFile 2.1.0.0 Technology Pack installation directory
	Installing the technology pack by using the launchpad
	UBA collectors
	Adding a UBA collector for a UBA pack

	Log files

	Chapter 4. Configure the technology pack
	Verifying resources
	Configuring Secure File Transfer support in Alcatel-Lucent 5620 SAM LogToFile 2.1.0.0 Technology Pack

	Chapter 5. Upgrading the Alcatel-Lucent 5620 SAM 2.12.0.0 Technology Pack to Alcatel-Lucent 5620 SAM LogToFile 2.1.0.0
	Chapter 6. Installation and configuration of IBM InfoSphere Information Server and related components
	Planning for IBM InfoSphere Information Server software installation
	Installing IBM InfoSphere Information Server 8.7 software
	Installing IBM InfoSphere Information Server by using the wizard (graphical mode)
	Installing IBM InfoSphere Information Server client by using the wizard (graphical mode)
	Verifying and testing the installation


	Installing Apache ActiveMQ
	Proviso collector mapping

	Chapter 7. Configure the InfoSphere Information Server components
	Opening the IBM InfoSphere Information Server web console
	Configuring web browser to open the IBM InfoSphere Information Server web console
	Configuring Microsoft Internet Explorer to open the IBM InfoSphere Information Server web console
	Configuring Mozilla Firefox to open the IBM InfoSphere Information Server web console

	Configuring the dsenv file
	Creating users in the IBM InfoSphere Information Server web console
	Configuring the DataStage job for Secure File Transfer support

	Chapter 8. Deploying Alcatel-Lucent 5620 SAM LogToFile 2.1.0.0 DataStage jobs
	Starting the Designer client
	Setting up a project
	Extracting the job archive file
	Importing an IBM InfoSphere DataStage job
	Configuring the DataStage job
	Configuring the CSV files in the cfg directory
	Updating the operator.apt file
	Enabling the firewall on the IBM InfoSphere Information Server and WebSphere Application Server

	Compiling the job
	Running the job
	Viewing the JMS message flow from SAM server in Apache ActiveMQ

	Gracefully shutting down the job
	Starting the daemon manually

	Data flow in the data subdirectories
	Stopping and starting the IBM InfoSphere Information Server server engine

	Chapter 9. Setting up the Alcatel-Lucent 5620 SAM servers to support LogToFile
	Install SAM on the primary and redundant servers
	Synchronize the clocks
	Install the Alcatel-Lucent 5620 SAM Client GUI
	Configure an OSS user account
	Configure the SAM accounting and polling statistics
	Enable the MIBs for the SAM statistics classes

	Set up ping tests

	Chapter 10. Modifying the collection strategy
	Specifying what inventory and metrics to collect
	Configuring multiple UBA collectors instances

	Changing the collection period for SAM statistics
	General guidelines on changing the collection period for SAM statistics

	List of classes that must be enabled or disabled

	Chapter 11. Troubleshooting Alcatel-Lucent 5620 SAM LogToFile Technology Pack
	Specifying parameter values
	Inventory issues
	Metric data collection issues
	Overview of metric data
	SAM metrics do not display in the Alcatel-Lucent 5620 SAM Client GUI
	SAM metric files are empty or do not exist in the SAM server
	BOF files do not exist in the FTE output directory
	BOF files do not exist in the CME output directory
	Metrics collection fails due to lack of disk space


	General Alcatel-Lucent 5620 SAM LogToFile 2.1.0.0 Technology Pack issues
	The subelement time changes on several unexpected occasions
	Synchronize the time on the IBM InfoSphere Information server and the SAM server
	Data is not displayed properly in the Volume and Utilization report
	Partitioning must be done at the element level
	The CSV filename changes when you map another class that does not correspond to its collector
	Device and Service Availability feature causes missing intervals in the report
	The OAM data exists at the SAM server but is not transferred to DataStage

	General IBM InfoSphere Information Server software related issues
	Troubleshooting IBM InfoSphere Information Server installations
	DataStage job stops running because of insufficient buffer size
	How to turn off the keepAlive message flag
	Verifying that the ports are enabled for all the components required for Alcatel-Lucent 5620 SAM LogToFile 2.1.0.0 Technology


	Notices
	Trademarks


